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Copyright © Tektronix. All rights reserved. 使用許諾ソフトウェア製品は、Tektronix またはその子会社や供給者が
所有するもので、米国著作権法および国際条約の規定によって保護されています。

Tektronix 製品は、登録済および出願中の米国その他の国の特許等により保護されています。 本書の内容は、既に
発行されている他の資料の内容に代わるものです。 また、本製品の仕様および価格は、予告なく変更させていただ
く場合がございますので、予めご了承ください。

TEKTRONIX および TEK は Tektronix, Inc. の登録商標です。

Tektronix 連絡先

Tektronix, Inc.
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

製品情報、代理店、サービス、およびテクニカル・サポート：
北米内：1-800-833-9200 までお電話ください。
世界の他の地域では、www.tektronix.com にアクセスし、お近くの代理店をお探しください。



保証

当社では、本製品において、出荷の日から 1 年間、材料およびその仕上がりについて欠陥がないことを保証します。
この保証期間中に製品に欠陥があることが判明した場合、当社では、当社の裁量に基づき、部品および作業の費
用を請求せずに当該欠陥製品を修理するか、あるいは当該欠陥製品の交換品を提供します。保証時に当社が使用
する部品、モジュール、および交換する製品は、新しいパフォーマンスに適応するために、新品の場合、または再生
品の場合もあります。交換したすべての部品、モジュール、および製品は当社で保有されます。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただき、サービス実施のための適切な措置を講じていただきます。お客様には、当該欠陥製品を梱包していただ
き、送料前払いにて当社指定のサービス・センターに送付していただきます。本製品がお客様に返送される場合に
おいて、返送先が当該サービス・センターの設置されている国内の場所であるときは、当社は、返送費用を負担し
ます。しかし、他の場所に返送される製品については、すべての送料、関税、税金その他の費用をお客様に負担し
ていただきます。

本保証は、不適切な使用または不適切もしくは不十分な保守および取り扱いにより生じたいかなる欠陥、故障または
損傷にも適用されません。当社は、以下の事項については、本保証に基づきサービスを提供する義務を負いません。
a）当社担当者以外の者による本製品のインストール、修理またはサービスの試行から生じた損傷に対する修理。b）不
適切な使用または互換性のない機器への接続から生じた損傷に対する修理。c）当社製ではないサプライ用品の使用
により生じた損傷または機能不全に対する修理。d）本製品が改造または他の製品と統合された場合において、改造
または統合の影響により当該本製品のサービスの時間または難度が増加したときの当該本製品に対するサービス。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥製品を修理または交換する当社の責任は、本保証の不履行についてお客様に提供される唯一の排他的な法
的救済となります。間接損害、特別損害、付随的損害または派生損害については、当社およびそのベンダは、損害
の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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保証

当社では、ソフトウェア製品を提供する目的で使用されているメディア、およびそのメディア上のプログラムのエンコー
ドにおいて、出荷の日から 3 か月間、材料およびその仕上がりについて欠陥がないことを保証します。この保証期
間中にメディアまたはエンコードに欠陥があることが判明した場合、当社では、当該欠陥メディアの交換品を提供し
ます。ソフトウェア製品を提供する目的で使用されているメディアを除き、本ソフトウェア製品は、明示的保証または
暗示的保証を問わず何等保証のない "現状有姿" のまま提供されています。当社では、本ソフトウェア製品に含ま
れる機能がお客様の要求を満たすこと、プログラムの動作が中断されないこと、エラーが発生しないことのいずれも
保証いたしません。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に通知して
いただきます。お客様から通知を受けた後、妥当な期間内に材料およびその仕上がりに欠陥がない交換品を提供
できない場合、お客様は、本ソフトウェア製品のライセンスを終了して本製品とその関連材料を返却し、お客様が既
に支払った代金を払い戻すことができます。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供するも
のです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を否認します。
欠陥メディアの交換またはお客様が支払った代金払い戻しを行う当社の責任は、本保証の不履行についてお客様
に提供される唯一の排他的な法的救済となります。間接損害、特別損害、付随的損害または派生損害については、
当社およびそのベンダは、損害の実現性を事前に通知されていたか否に拘わらず、一切の責任を負いません。
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重要

機器を操作する前にお読みください

本ソフトウェアは、Tektronix, Inc. からのライセンスに基づき提供されます。本プログラムの保有期間が 30 日を超え
た場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本ライセンス条項を承諾したものと
みなされます。

同梱のソフトウェア・ライセンス契約書をよくお読みください。本ライセンス条項にご同意頂けない場合、最寄りのテク
トロニクス営業所までお早めにお問い合わせの上、返品に関する手配をご用命ください。

テクトロニクス・ソフトウェア・ライセンス契約書

機器内に搭載されたプログラムも含む本プログラムは、本契約条項を条件として提供されます。本プログラムの保有
期間が 30 日を超えた場合、または方法の如何を問わず本プログラムが使用された場合、お客様は、本契約条項を
承諾したものとみなされます。これらの条項にご同意頂けない場合、未使用のプログラムおよび関連資料をテクトロ
ニクスへ至急ご返送ください。お支払い頂いたライセンス料金を全額払い戻します。（機器に搭載された本プログラ
ムの返却については、最寄りのテクトロニクス営業所までお問い合わせください。）

定義: 「テクトロニクス」とは、機器を供給している米国オレゴン州法人 Tektronix, Inc. または他の国もしくは地域の
テクトロニクス・グループ法人を意味します。

「本プログラム」とは、本契約書に同梱のテクトロニクスのソフトウェア製品（実行可能形式のプログラムおよび／また
はデータ）、または本契約書に同梱の機器に搭載されたテクトロニクスのソフトウェア製品（実行可能形式のプログラ
ムおよび／またはデータ）を意味します。

「お客様」とは、本プログラムを発注した個人または組織を意味します。

ライセンス: お客様は、次の行為を行うことができます。

a. 一時点で 1 台の機器上でのみ本プログラムを使用すること。

b. 本プログラムがフローティング・ユーザ・ライセンスに基づき提供された場合、正規ユーザが複数台の機器上
で本プログラムを使用すること。ただし、一時点での正規ユーザ総数がライセンスに規定の同時使用ユーザ
総数を超えないことを条件とします。

c. 1 台の機器上で使用することを条件として、本プログラムを改変し、または他のプログラムと併合すること。

d. 保管またはバックアップの目的で本プログラムを複製すること。ただし、かかる複製物がどの時点においても 1
部を超えて存在しないことを条件とします。本プログラムがフローティング・ユーザ・ライセンスに基づき提供され
た場合、正規ユーザが使用することを条件として、複数台の機器上に本プログラムをコピーすることができます。



お客様は、自己が作成した本プログラムの各複製物に対し、テクトロニクスから受領した本プログラムと同一の著作
権表示および権利制限事項を明示する必要があります。

お客様は、次の行為を行うことができません。

a. フローティング・ユーザ・ライセンスまたは別途のサイト・ライセンスに基づく場合を除き、同時に複数台の機
器上で本プログラムを使用すること。

b. テクトロニクスから書面による事前の許可を得ることなく、第三者もしくは外部の組織に対し本プログラムを譲
渡すること、またはお客様が所属している法人に対し本プログラムを譲渡すること。ただし、本プログラムが搭
載されている機器を譲渡する場合を除きます。

c. 管轄権を有する米国または他国政府の法令により輸出または再輸出が制限されている国に対し、必要とされ
る場合の米国商務省輸出管理局およびかかる他国政府機関の事前の許可なく、本プログラム、関連資料ま
たはこれらの直接的産物を直接または間接的に輸出または再輸出すること。

d. オブジェクトコード形式の本プログラムについて、目的の如何を問わず逆コンパイルまたは逆アセンブルを行
うこと。

e. 本プログラムの関連資料を複製すること。

本プログラムを複数の機器に個別に搭載してそれぞれをローカルで稼動させるのではなく、1 台の機器のみに搭載
してそこから他の機器をローカルまたはリモートでサポートするという運用形態をとる場合、かかる他の機器は、「1 台
の機器」の定義に含まれるものとします。本プログラムを複数の機器に個別に搭載してそれぞれをローカルで稼動さ
せるという運用形態をとる場合、本プログラムを使用する機器ごとに、またはフローティング・ユーザ・ライセンスに基
づく正規の同時使用ユーザごとに別個のライセンスが必要となります。

本プログラムおよびそのすべての複製物（本プログラムまたはかかる複製物が存在するメディアを除きます）に係る
権利は、テクトロニクスに、またはテクトロニクスが各ライセンス権を取得した第三者に帰属します。

お客様は、本プログラムの保有もしくは使用または本ライセンスについて本契約発効以後に課されるすべての税金
を期限までに支払い、かかる税金につき必要とされるすべての届出を行います。

本プログラムのうちお客様により改変された部分、または他のプログラムと併合された部分に対しても、本契約条項
が適用されます。

本プログラムが米国政府機関により、または当該機関のために取得された場合、本プログラムは、私企業の費用負担
にて開発されたコンピュータ・ソフトウェアとみなされ、本契約におけるライセンス許諾は、調達関係の適用法令にて定
義されるとおり、本プログラムおよび関連資料における制限された権利をお客様に許諾することとして解釈されます。

本契約条項により明示的に許可された場合を除き、お客様は、本プログラムを使用、複製、改変、併合、または第
三者に譲渡することができません。

本プログラムの複製物、改変物、または併合部分が譲渡された場合、本契約において許諾されたライセンスは、自
動的にただちに解約されます。

期間: 本契約において許諾されたライセンスは、お客様が本契約を承諾した時点を以て発効し、本契約の規定に
より解約されるまで有効に存続します。お客様は、テクトロニクスに書面にて通知することにより、本ライセンスをいつ
でも解約することができます。お客様が本契約条項に違反した場合において、テクトロニクスまたはテクトロニクスが
各ライセンス権を取得した第三者からその旨の通知があった日から 30 日以内にかかる違反が是正されなかったと
きは、テクトロニクスまたはかかる第三者は、本ライセンスを解約することができます。本契約の解約後、お客様は、
本プログラムおよび関連資料を、形態の如何を問わずその複製物のすべてと共に、ただちにテクトロニクスに返還
し、または破棄します。

制限保証: テクトロニクスは、本プログラムが提供されたメディアおよび本プログラムのメディアへの記録状態に材
質および製造上の欠陥がないことを、発送後３ヵ月間保証します。当該保証期間中にかかるメディアまたは記録状
態に欠陥があることが判明した場合、テクトロニクスは、欠陥メディアと交換に代替品を提供します。本プログラムが
提供されたメディアに関する場合を除き、本プログラムは、明示または黙示の何等の保証もなく現状のままで提供さ



れます。テクトロニクスは、本プログラムの機能がお客様の要求を満たすこと、および本プログラムに動作の中断また
は誤動作が全くないことについては保証しません。

本保証に基づくサービスを受けるため、お客様は、当該保証期間の満了前に欠陥をテクトロニクスに通知します。
その後合理的な期間内にテクトロニクスが材質および製造上の欠陥のない代替品を提供することができなかった場
合、お客様は、かかる本プログラムのライセンスを解約することができ、支払済ライセンス料があればその払戻を受け
て本プログラムおよび関連資料を返却することができます。

本保証は、明示であると黙示であるとを問わず、他の一切の保証に代わって、本プログラムにつきテクトロニクスによ
り行われます。テクトロニクスおよびその販売店は、商品性または特定目的に対する適合性についての一切の黙示
保証を否認します。本保証の違反につきお客様に為される救済は、テクトロニクスが欠陥メディアを交換し、または
お支払済ライセンス料があればその払戻を行うことに限定されます。

責任の制限：　お客様による本プログラムの保有または使用に起因または関係する間接損害、特別損害、付随的損
害、および派生損害については、テクトロニクスおよびテクトロニクスがライセンス権を取得した第三者は、かかる損
害が発生し得る旨の事前通知を受けていた場合といえども、いかなる責任をも負いません。

第三者の免責事項: 別途明示的に合意した場合を除き、テクトロニクスがライセンス権を取得した第三者は、本プ
ログラムにつきいかなる保証も行わず、本プログラムの使用につきいかなる責任も負わず、また、本プログラムに関す
る支援または情報を提供するいかなる義務をも負いません。

一般条項: 本契約書は、本プログラムの使用、複製、及び譲渡に関する当事者間の完全なる合意事項を構成し
ます。

お客様は、テクトロニクスの事前の書面による同意なく、本契約及び本契約において許諾されたライセンスを第三者
に譲渡することができません。

本契約および本契約において許諾されたライセンスは、米国オレゴン州法令に準拠します。

本契約または本契約において許諾されたライセンスにつきご不明な点がございましたら、最寄りのテクトロニクス営
業所までお問い合わせください。

ビデオ・テスト・シーケンスに対する追加ライセンス供与: ソフトウェア製品には何らかのテスト・パターン、ビデ
オ・テスト・シーケンス、およびビデオ・クリップ（合わせて「ビデオ・テスト・シーケンス」）が含まれている場合がありま
す。その場合、ビデオ・テスト・シーケンスに関するお客様の権利は以下の条項のとおりです。

お客様はビデオ・テストの実行に伴い、ビデオ・テスト・シーケンスの使用、複製、改変、ならびに個々のビデオ・テス
ト・シーケンスの表示もしくは複製の配布を行うことができます。

お客様は、以下のいかなる行為についても許諾されていません。

お客様はテクトロニクスからの書面による事前の許可を得ることなく、ビデオ・テスト・シーケンスの集合体につい
て、かかるビデオ・テスト・シーケンスを含む元の機器を売却する場合を除き、配布することはできません。

お客様は、ビデオ・テスト・シーケンスの第三者による配布を許可することはできません。

お客様は、本ビデオ・テスト・シーケンスの複製を単独で販売、ライセンス供与、もしくは配布してはなりません。ま
たかかるビデオ・テスト・シーケンスが製品やサービスの価値の主体をなす場合は、いかなる集合体、製品、サー
ビスの一部としても販売、ライセンス供与、もしくは配布することはできません。

お客様は、お客様によって改変されたビデオ・テスト・シーケンスの使用もしくは配布の結果生じたいかなる申立ても
しくは訴訟（弁護士費用を含む）に対してもテクトロニクスを免責し、補償し、また弁護しなければなりません。

お客様の製品やサービスにかかるビデオ・テスト・シーケンスの複製を含める場合は有効な著作権表示を含めなけ
ればなりません。





目次

目次

安全にご使用いただくために.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iii

適合性 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

EMC .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v

安全性 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi

環境条件について.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii

まえがき . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix

主な特長 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix

マニュアル . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix

このマニュアルで使用される表記規則 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . x

設置  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

設置の前に.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

動作条件.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

ハードウェアの設置 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

本機器への接続.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

機器の電源をオンにする. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

機器の電源をオフにする. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

VLC メディア・プレーヤのインストール . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

ネットワーク構成 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

機能チェック. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

操作. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

フロント・パネル・コントロールおよびコネクタ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19

リア・パネル・コネクタ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

ソフトウェア・アプリケーション . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

アプリケーションの起動 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23

メニュー・コマンドへのアクセス . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

数値データの入力 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

デュプレックス操作 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26

手順. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

MTS400 シリーズ・アプリケーションの使用. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

イーサネット・ネットワーク・パラメータの設定.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

オペレーティング・システム・ソフトウェアのリストア . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

使用例 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

トランスポート・ストリームの作成、表示、および解析 .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

IP ストレス･テスト. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

アクセサリ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

スタンダード・アクセサリ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

オプショナル・アクセサリ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

ユーザ・メンテナンス . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

一般的な注意事項 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

予防保全.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

問題が発生した場合. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

輸送用の再梱包.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

MTS400P 型クイック・スタート・ユーザ・マニュアル i



目次

索引

ii MTS400P 型クイック・スタート・ユーザ・マニュアル



安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次の安全性に
関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合があります。
システムの操作に関する警告や注意事項については、他製品のマニュアルにある安全に関するセクション
をお読みください。

火災や人体への損傷を避けるには

適切な電源コードを使用してください。 本製品用に指定され、使用される国で認定された電源コードの
みを使用してください。

本製品を接地してください。 本製品は、電源コードのグランド線を使用して接地します。 感電を避けるた
め、グランド線をアースに接続する必要があります。 本製品の入出力端子に接続する前に、製品が正しく接
地されていることを確認してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべての定格と
マーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、製品マニュアルを参
照してください。

本製品の定格は測定カテゴリＩになります。一次回路、設置カテゴリＩＩ，ＩＩＩ，およびＩＶの回路には接続しな
いでください。

電源を切断してください。 電源コードの取り外しによって主電源が切り離されます。電源コードをさえぎら
ないでください。このコードは常にアクセス可能であることが必要です。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作させな
いでください。

故障の疑いがあるときは動作させないでください。 本製品に故障の疑いがある場合、資格のあるサー
ビス担当者に検査してもらってください。

露出した回路への接触は避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに
触れないでください。

適切なヒューズを使用してください。 本製品用に指定されたタイプおよび定格のヒューズのみを使用し
てください。

湿気の多いところでは動作させないでください。

爆発性のあるガスがある場所では使用しないでください。

製品の表面を清潔で乾燥した状態に保ってください。

適切に通気してください。 適切な通気が得られるような製品の設置方法の詳細については、マニュアル
の設置方法を参照してください。
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安全にご使用いただくために

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 人体や生命に危害をおよぼすおそれのある状態や行為を示します。

注意： 本製品やその他の接続機器に損害を与える状態や行為を示します。

本製品に関する記号と用語

本製品では、次の用語を使用します。

DANGER: ただちに人体や生命に危険をおよぼす可能性があることを示します。

WARNING: 人体や生命に危険をおよぼす可能性があることを示します。

CAUTION: 本製品を含む周辺機器に損傷を与える可能性があることを示します。

本製品では、次の記号を使用します。
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適合性

適合性

このセクションでは、本機器が適合している EMC 基準、安全基準、および環境基準について説明します。

EMC

EC 適合宣言 - EMC

指令 2004/108/EC 電磁環境両立性に適合します。『Official Journal of the European Communities』に記載
の以下の仕様に準拠します。

EN 61326-1:2006: 測定、制御、および実験用途の電子機器を対象とする EMC 基準。 1 2 3

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション

IEC 61000-4-2:2001：静電気放電イミュニティ

IEC 61000-4-3:2002：RF 電磁界イミュニティ

IEC 61000-4-4:2004：ファスト・トランジェント／バースト・イミュニティ

IEC 61000-4-5:2001：電源サージ・イミュニティ

IEC 61000-4-6:2003：伝導 RF イミュニティ

IEC 61000-4-11:2004：電圧低下と停電イミュニティ

EN 61000-3-2:2006: AC 電源高調波エミッション

EN 61000-3-3:1995: 電圧の変化、変動、およびフリッカ

欧州域内連絡先:
Tektronix UK, Ltd.
Western Peninsula
Western Road
Bracknell, RG12 1RF
United Kingdom

1 本製品は住居区域以外での使用を目的としたものです。住居区域で使用すると、電磁干渉の原因となることがあります。

2 本製品をテスト対象に接続した状態では、この規格が要求するレベルを超えるエミッションが発生する可能性があります。

3 ここに挙げた各種 EMC 規格に確実に準拠するには、高品質なシールドを持つインタフェース・ケーブルが必要です。

オーストラリア／ニュージーランド適合宣言 - EMC

ACMA に従い、次の規格に準拠することで Radiocommunications Act の EMC 条項に適合しています。

CISPR 11:2003：グループ 1、クラス A、放射および伝導エミッション（EN 61326-1:2006 に準拠）
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適合性

安全性

EC 適合宣言 - 低電圧指令

『Official Journal of the European Communities』に記載の以下の基準に準拠します。

低電圧指令 2006/95/EC

EN 61010-1:2001：測定、制御および実験用途の電子装置に対する安全基準

米国の国家認定試験機関のリスト

UL 61010-1:2004 年第 2 版。電子計測機器および試験用機器の標準規格

カナダ規格

CAN/CSA C22.2 No.61010-1:2004：測定、制御、および研究用途の電子装置に対する安全基準、第 1 部

その他の基準に対する適合性

IEC 61010-1:2001：測定、制御、および実験用途の電子装置に対する安全基準

機器の種類

測定機器

安全クラス

クラス 1：アース付き製品

汚染度

製品内部およびその周辺で発生する可能性がある汚染の尺度です。通常、製品の内部環境は外部環境と
同じとみなされます。製品は、その製品に指定されている環境でのみ使用してください。

汚染度 1：汚染なし、または乾燥した非導電性の汚染のみが発生します。このカテゴリの製品は、通常、
被包性、密封性のあるものか、クリーン・ルームでの使用を想定したものです。

汚染度 2：通常、乾燥した非導電性の汚染のみが発生します。ただし、結露によって一時的な導電性が
発生することもまれにあります。これは、標準的なオフィスや家庭内の環境に相当します。一時的な結露
は製品非動作時のみ発生します。

汚染度 3：導電性のある汚染、または通常は乾燥して導電性を持たないが結露時に導電性を帯びる汚
染。これは、温度、湿度のいずれも管理されていない屋内環境に相当します。日光や雨、風に対する直
接の曝露からは保護されている領域です。

汚染度 4：導電性のある塵、雨、または雪により持続的な導電性が生じる汚染。これは一般的な屋外環
境に相当します。
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適合性

汚染度

汚染度 2（IEC 61010-1 の定義による）。注：屋内使用のみについての評価です。

MTS400P 型クイック・スタート・ユーザ・マニュアル vii



適合性

環境条件について
このセクションでは本製品が環境に及ぼす影響について説明します。

使用済み製品の処理方法

機器またはコンポーネントをリサイクルする際には、次のガイドラインを順守してください。

機器のリサイクル: 本製品の製造には天然資源が使用されています。本製品には環境または人体に有
害となる可能性のある物質が含まれているため、廃棄の際には適切な処理が必要です。有害物質の放出
を防ぎ、天然資源の使用を減らすため、機材の大部分を再利用またはリサイクルできる適切な方法で処理
してください。

このマークは、本製品が WEEE Directive 2002/96/EC（廃棄電気・電子機器に関する指令）に
基づく EU の諸要件に準拠していることを示しています。リサイクル方法については、Tektronix
Web サイト（www.tektronix.com）の「Service & Support」のセクションを参照してください。

水銀に関するお知らせ: この製品に使用されている LCD バックライト・ランプには、水銀が含まれてい
ます。廃棄にあたっては、環境への配慮が必要です。廃棄およびリサイクルに関しては、お住まいの地域
の所轄官庁にお尋ねください。

過塩素酸塩材: 本製品には 1 つまたは複数の CR 型リチウム電池が搭載されています。CR 型リチウム電
池はカリフォルニア州法により過塩素酸塩材として規定され、特別な取り扱いが求められています。詳細に
ついては、www.dtsc.ca.gov/hazardouswaste/perchlorate を参照してください。

有害物質に関する規制

本製品は Monitoring and Control（監視および制御）装置に分類されており、2002/95/EC RoHS Directive
（電気・電子機器含有特定危険物質使用制限指令）の適用範囲外です。
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まえがき

まえがき

このマニュアルでは、当社の MTS400P 型 MPEG テスト・システムの機能と使用方法について説明します。
このマニュアルでは、次の規則に従って製品名を表します。

MTS400P 型システム：MTS400P 型のみを表します。

MTS415 型、MTS430 型、および MTS4SA 型の操作については、『MTS400 シリーズ・クイック・スタート・
ユーザ・マニュアル』（当社部品番号：071-2607-XX）を参照してください。

MTS400 シリーズ・システム： MTS415 型、MTS430 型および MTS4SA 型を表します。

主な特長
MPEG、DVB、ATSC、ISDB、および ISDB-TB（ブラジル）などの広範囲の DTV 規格をサポートしていま
す。これらの規格の地上波、ケーブル、衛星、および地域別の放送方式に特定の SI が対応します。

さまざまなインタフェースと解析機能により、RF または IP レイヤ・トランスミッション・リンクやトランスポー
ト・ストリーム・コンテンツ処理など、あらゆるネットワーク環境で発生する問題を診断するために必要な
接続が実現します。

クロスレイヤ障害解析やログ機能が内蔵されているため、1 つの機器で障害診断を行うことができ、トラ
ブルシューティング時の調査にかかる時間を短縮できます。

再生機能を用いれば、IP マルチセッションのレプリケーションをシミュレートすることで、被測定ネットワー
クや被測定デバイスの動作を評価できます。

CaptureVu™ 技術では、システム上のイベントをリアルタイムまたはオフラインで取り込んで解析できます。

革新的でプログラム中心のユーザ・インタフェースによって、経験の長短を問わず、誰でも専門家並み
の判断を下すことができます。

多重ストリームおよびエレメンタリ・ストリームのコンプライアンスをチェックする H.264 バッファ解析では、
H.264 コンテンツが含まれるトランスポート・ストリームの作成と解析に使用できる強力なツール群が提供
されます。

マニュアル
このマニュアルでは、MTS400P 型 MPEG テスト・システムの設置と基本的な操作方法について説明します。
また、この製品には以下のマニュアルがあります。

項目 目的 参照先

MTS400P 型 ク イ ッ ク ・ ス
ター ト ・ ユーザ ・マニュア
ル （ 071-2610-XX 英 語 、
071-2611-XX 日本語）

本テスト・システムの設置
方法と基本的な使用方法
について説明します。

MTS400 シリーズ・アナライザ・
アプリケーション・ユーザ・マ
ニュアル（077-0205-XX）

アナライザ・アプリケーショ
ン（TSCA、PES アナライザ、
T-STD バッファ・アナライ
ザ、および ES アナライザ）
の操作について説明しま
す。

MTS400P 型クイック・スタート・ユーザ・マニュアル ix
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項目 目的 参照先

MTS400 シリーズ・ゼネレー
タ・アプリケーション・ユーザ・
マニュアル（077-0204-XX）

ゼネレータ・アプリケーショ
ン（マルチプレクサ、MPEG
Player、TS エディタ、シー
ムレス化機能、トランスポー
ト・ストリーム・カッタ、および
スクリプト・パッド）の操作に
ついて説明します。

MTS400 シリーズ・カルーセ
ル・アプリケーション・ユーザ・
マニュアル（077-0203-XX）

カルーセル・アナライザお
よびカルーセル・ゼネレー
タ・アプリケーションの操作
について説明します。

MTS400 シリーズ・プログラマ・
マニュアル（077-0206-XX）

MPEG Player アプリケー
ションの制御用プログラマ・
コマンドについて説明しま
す。

MTS400 シリーズ・リリース・
ノート（077-0200-XX）

テスト・システムに関する既
知の問題について説明し
ます。

ユーザ・マニュアルは、Tektronix の Web サイト（www.tektronix.com/manuals）からダウンロードできます。

次の URL を使用すると、次の標準機関の Web サイトにアクセスできます。一覧にある URL はこのマニュア
ルの作成時点で有効な URL です。

MPEG-2 規格（国際標準化機構）– www.iso.org/

DVB 規格（欧州電気通信標準化機構）– www.etsi.org/

ATSC 規格（高画質テレビ・システム委員会）– www.atsc.org/

このマニュアルで使用される表記規則
このマニュアルでは、次のようなマークが使用されています。

手順番号 フロント・パ
ネルの電源

電源の接続 ネットワーク PS2 SVGA USB

x MTS400P 型クイック・スタート・ユーザ・マニュアル

www.iso.org/
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設置の前に
機器を受け取ったら、次の手順で検査を実行してください。

1. 輸送用段ボール箱に、機器破損の可能性を示す外部損傷がないかどうかを検査します。

2. 輸送用段ボール箱から MTS400P 型 MPEG テスト・システムを取り出します。

3. 輸送中に機器に損傷がなかったかどうかを調べます。機器の外側に傷や衝撃の痕跡がないことを確認
してください。出荷に先立ち、機器は機械的損傷の有無を徹底的に検査されています。

注： 輸送が必要になった場合に機器を再梱包できるように、段ボール箱や梱包材は保管しておいてくださ
い。 (82 ページ 「輸送用の再梱包」 参照)。

4. 標準アクセサリおよびご注文のオプショナル・アクセサリがすべて届いていることを確かめてください。
(77 ページ 「アクセサリ」 参照)。

5. 機器の設置後に、機能チェックの手順を実行します。 (17 ページ参照)。

動作条件
機器を設置する前に、このマニュアルの先頭の「安全にご使用いただくために」のセクションで、電源、アー
ス、その他の安全に関する情報を参照してください。

動作環境要件

次の表を見て、現在の設置場所が適切な動作環境要件を満たしていることを確認してください。動作要件
の詳細については、『MTS400P 型仕様および性能検査テクニカル・リファレンス』を参照してください。

注意： 指定の温度範囲から外れた環境で電源をオンにすると、機器が損傷する可能性があります。

表 1: 動作環境要件

特性 仕様

MTS400P 型の周囲温度 +5 ℃ ～ +40 ℃（+41 °F ～ +104 °F）

最高動作高度 3000 m （9842 フィート）

MTS400P 型の相対湿度 20% ～ 80%

上部スペース 5.0 cm（2 インチ）

左側面スペース 5.0 cm（2 インチ）

右側面スペース 5.0 cm（2 インチ）

MTS400P 型クイック・スタート・ユーザ・マニュアル 1
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表 1: 動作環境要件 （続き）

特性 仕様

リア・スペース（ファン・ガードから） 5.0 cm（2 インチ）

注： 機器を専用ラックに設置する場合は、ラックマウント・キットに付属の取扱説明書を参照して正しい設
置手順で行ってください。

MTS400P 型システムを 19 インチ・ラックに設置する場合は、機器の上部に少なくとも 1 ユニットのスペース
があることを確認してください。

AC 電源の電圧要件

設置場所が正しい電源要件を満たしていることを確認します。表 2 を参照してください。

表 2: AC 電源要件

パラメータ 説明

電源の電圧範囲 100 ～ 240 V

電源周波数 50/60 Hz

最大電力 180 VA

注意： この機器には電源スイッチがありませんが、On/Standby スイッチがついています。電源ケーブルを
AC コンセントに接続すると、機器の電源スタンバイ回路に電力が供給されます。電源ケーブルを電源に差
し込む前に、電源投入に関する説明を参照してください。 (10 ページ 「機器の電源をオンにする」 参照)。

電源コードの要件

設置場所に適合した正しい電源コードであることを確認してください。リア・パネルの電源コネクタから電源
システムに電源コードを接続します。 (77 ページ 「アクセサリ」 参照)。

注意： 機器は、電源システムに合った電源コードを同梱して出荷されます（通常の 115 V 電源システムま
たは 230 V 電源システム）。ご注文時の指定とは異なる電力系統で機器を使用する場合は、必ずそれに見
合う電源コードに変更してください。
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ハードウェアの設置
MTS400P 型システムはポータブル設計です。解析機能（有効な場合）は、電源を供給し、機器のハード・
ディスク上でトランスポート・ストリームを利用できるようにするだけで使用できます。監視およびリアルタイム
解析機能は同様に電源を必要としますが、外部トランスポート・ストリームへの接続も必要となります。

MTS400P 型システムは、購入時に注文したソフトウェアおよびハードウェア・オプションで構成されます。
MTS400P 型システムのオプションは、当社が提供するアップグレード・キットを使用して追加できます。

機器を設置する際には、フロント・パネルの USB コネクタにキーボードおよびマウスを接続します。パラレル・
ポート・ソフトウェア・キーが取り付けられており、固定ネジが 4 インチポンドのトルク（45 ニュートン cm）に締
め付けられていることを確認します。

注意： 静電気放電による機器の損傷を防ぐために、機器を操作する前にパラレル・ポート・ソフトウェア・キー
の固定ネジが正しく締め付けられていることを確認してください。

注： MTS400P 型システムのアプリケーションは、ソフトウェア・キーが取り付けられていないと動作しません。
ソフトウェア・キーを機器から取り外さないでください。

ソフトウェア・キーが取り付けられた状態でパラレル・ポートを使用するには、パラレル・ポート・ケーブル（プリ
ンタ・ケーブルなど）をソフトウェア・キーに直接取り付けます。ソフトウェア・キーによってパラレル通信が阻
害されることはありません。

注： アップグレードまたは修理のためにテスト・システムを当社サービス受付センターに返送する場合は、
ソフトウェア・キーを取り外さないでください。

BNC ケーブルの取り付け（GbE インタフェースのみ）

以下の図に示すように、オプション IPTVP 型に付属している BNC ケーブルを接続します。
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オプションの IP ビデオ GbE（ギガビット・イーサネット）インタフェース・カードを使用すると、銅線ネットワーク
および光 IP ネットワーク上の映像品質をリモートで監視および測定できます。SFP（Small Format Pluggable）
モジュールはさまざまな光波長に対応しています。

警告： 有害なレーザー光線にさらされるのを避けるため、米国の連邦規制 CDRH 21 CFR 1040 および
IEC/EN 60825/A2:2001 で規定されているように、Class 1 レーザーのみを使用してください。

注意： 静電気放電による損傷を防ぐため、製品のサービスは静電気の起こらない環境においてのみ行っ
てください。このモジュールの設置中は、静電気の影響を受けやすい機器取り扱い時の標準的な注意事項
を守ってください。このモジュールを取り付けるときは、必ず、接地したリスト・ストラップ、接地したフット・ス
トラップ、および静電気防止衣服を着用してください。

次の図は、光ポート・プラグを取り外した状態の SFP モジュールです。ケーブルを接続していないとき、また
はモジュールを使用していないときは、このプラグを使用して光インタフェースを保護します。

注： ケーブルを接続していないときは、光ポート・プラグを必ず取り付けてください。
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SFP モジュールの取り付け: SFP モジュールをオプション IPTVP 型のインタフェース・モジュールに取り
付けるには、次の手順に従います。

注意： SFP モジュールの損傷を避けるために、SFP モジュールの取り外しや挿入は、MTS400P 型システム
から電源を切断してから行ってください。

1. 本機器から電源コードを抜きます。

2. オプション IPTVP 型モジュールのリア・パネルに "SFP 1000" と表示されたコネクタがあります。このコネ
クタに SFP モジュールを挿入します。完全に押し込むと、モジュールが噛み合います。

3. 光ポート・プラグを外し、SFP モジュールに光ファイバ・ケーブルを挿入します。次の図を参照してくださ
い。完全に押し込むと、ケーブル・コネクタが噛み合います。光ポート・プラグは保管しておいてください。
本機器から SFP モジュールを取り外したとき、再び使用します。

4. 電源コードを本機器に再度接続します。
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SFP モジュールの取り外し: SFP モジュールをオプション IPTVP 型のインタフェース・モジュールから取
り外すには、次の手順に従います。

1. 本機器から電源コードを抜きます。

2. SFP モジュール・コネクタの上部を押して光ファイバ・ケーブルのラッチを解除し、その後、SFP モジュー
ルからケーブルを外します。

3. SFP モジュールの固定ラッチを押し下げ、次の図のように、本機器から SFP モジュールを取り外します。

4. 光ポート・インタフェースを保護するため、取り外した SFP モジュールに光ポート・プラグを取り付けます。

5. 電源コードを本機器に再度接続します。
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本機器への接続

フロント・パネル・コネクタ

フロント・パネルの 2 つの USB 2.0 ポートには、キーボードやマウスなどの USB デバイスを接続できます。

リア・パネル・コネクタ

表 3: リア・パネル・コネクタ

図 の 参
照番号 コントロール 機能

1 SPI In/Out SPI（同期パラレル・インタフェース）信号の入出力には、この 25 ピンの
D-sub コネクタを使用します。

2 Clock/Ref In 外部リファレンス信号またはクロック信号を入力するには、この BNC コ
ネクタを使用します。信号の仕様の詳細については、『MTS400P 型仕
様および性能検査テクニカル・リファレンス』を参照してください。

注： 外部リファレンス信号またはクロック信号には連続信号を使用して
ください。
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表 3: リア・パネル・コネクタ （続き）

図 の 参
照番号 コントロール 機能

3 Trig In/Out ストリームの記録用に外部トリガ・イベントを入力する場合、または 27
MHz のリファレンス・クロック信号もしくは ISDB-T フレーム・パルス信号
を出力する場合に、この BNC コネクタを使用します。Play メニューで構
成を変更できます。Trig In/Out 信号の詳細については、『MTS400P 型
仕様および性能検査テクニカル・リファレンス』マニュアルを参照してく
ださい。

4 SFP（Small Format
Pluggable）ポート

SFP 光ポートの取り付けには、このコネクタを使用します。

5 イーサネット 機器をイーサネットに接続するには、このコネクタを使用します。

6 ASI/SMPTE Input ASI/SMPTE 信号の入力には、この BNC コネクタを使用します。

7 ASI/SMPTE Out-
put

ASI/SMPTE 信号の出力には、この BNC コネクタを使用します。

8 SMPTE310M/ASI
Output

プレーヤの Play モードで SMPTE310M 信号または ASI（非同期シリア
ル・インタフェース）信号を出力するには、この BNC コネクタを使用しま
す。310M/ASI/SPI メニューで出力信号のフォーマットを選択できます。

注： SMPTE310M インタフェースは、19.392658 Mbps（8 VSB、パケット・
サイズ 188 バイト）のデータ・レートをサポートします。

9 SMPTE310M/ASI
Input

プレーヤの Record モードで SMPTE310M 信号または ASI（非同期シリア
ル・インタフェース）信号を入力するには、この BNC コネクタを使用しま
す。310M/ASI/SPI メニューで入力信号のフォーマットを選択できます。

10 SPI Input SPI（同期パラレル・インタフェース）信号の入力には、この 25 ピンの
D-sub コネクタを使用します。310M/ASI/SPI メニューでソース・フォー
マットを SPI/ASI/310M にしたり、入力ポートを選択できます。

注： SPI Input コネクタは、信号の入力にのみ使用できます。SPI をソー
スとして選択すると、ベース・カード上の SPI In/Out インタフェースで SPI
が有効になります。

11 VGA 機器の画面を外部モニタに表示するには、この 9 ピンの D-sub コネク
タを使用します。

外部モニタが接続された状態で機器の電源をオンにした場合にのみ、
VGA 出力が自動的に有効になります。機器の電源をオンにした後で
VGA 出力を有効にしたい場合は、次の手順を実行します。

1. Play 画面を最小化して Windows XP デスクトップを表示します。

2. タスクバーの右側にある Intel（R）Extreme Graphics 2M アイコンをク
リックします。

3. 表示されたメニューで、Graphic Options > Output To > Intel（R）Dual
Display Clone > Monitor+Notebook を選択します。
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表 3: リア・パネル・コネクタ （続き）

図 の 参
照番号 コントロール 機能

12 LAN
（ 10/100/1000
Base-T）

MTS400P 型システムをローカル・イーサネット・ネットワークに接続する
には、このコネクタを使用します。

13 Com この 9 ピンの D-sub コネクタは、機器制御用のシリアル･インタフェース
を提供します。

14 Printer プリンタの接続には、この 25 ピンの D-sub コネクタを使用します。このイ
ンタフェースは IEEE 1284 パラレル・ポート標準をサポートしています。

15 IEEE 1394b 外付けハード・ディスク・ドライブなどの IEEE 1394b デバイスの接続に
は、このコネクタを使用します。

16 電源 このコネクタを使用して、付属の電源コードで電源を機器に供給します。

MTS400P 型システムの PC への接続

MTS400P 型システムを PC に接続する方法には次の 2 通りがあります。

1. MTS400P 型システムを 1 台の PC
に直接接続する場合は、クロス型
イーサネット・ケーブルを使用して、
MTS400P 型システムの LAN ポート
と PC のイーサネット・ポートを接続
します。クロス・ケーブルを作成する
場合は、次の図に従って、ストレー
ト・ケーブルのピン接続を変更し、ク
ロス・ケーブルを作成してください。

2. MTS400P 型システムをローカル・
イーサネット・ネットワークに接続す
る場合は、ストレート型イーサネット・
ケーブルを使用して、MTS400P 型
システムの LAN ポートとローカル・
ネットワークのイーサネット・ハブ・
ポートを接続します。イーサネット・
ネットワークに接続することにより、
ネットワーク上の任意の PC を使用
して MTS400P 型システムにアクセ
スできます。

ローカル・イーサネット・ネットワーク上
に MTS400P 型システムを設置する方
法については、「ネットワーク構成」を参
照してください。 (12 ページ参照)。
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機器の電源をオンにする

1. 動作環境、AC 電源、および電源
コードの各要件を確認したら、リア･
パネルの電源コネクタに電源コード
を差し込み、次に電源コードを設置
場所のコンセントに差し込みます。

2. On/Standby スイッチを押して機器
の電源をオンにします。機器の電源
を投入後、リア・パネルのファンが作
動していることを確認してください。
ファンの作動を確認するには、機器
の右側後方に手を置いてください。
ファンのエア・フローが感じられるは
ずです。

注意： 機器の電源投入後に冷却ファ
ンが作動しない場合は、機器を動作さ
せないでください。冷却ファンが作動し
ないと、過熱により機器に重大な損傷
が生ずる可能性があります。

機器の電源をオフにする
必ず Windows XP の終了手順（Start > Shut down... または Start > Turn off computer）により電源をオフに
してください。システム（アプリケーションを含む）が自動的にシャット・ダウンします。メッセージが表示された
ら、フロント・パネルの On/Standby スイッチを押して機器の電源をオフにします。または、フロント・パネルの
On/Standby スイッチを 2 秒間押してから離します。以上の操作でシステムは自動的にシャット・ダウンし、電
源がオフになります。
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設置 

VLC メディア・プレーヤのインストール
トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）でビデオを見られるようにするには、VideoLAN
の Web サイトから最新バージョンの VLC メディア・プレーヤをダウンロードしてインストールする必要があり
ます。

1. インターネットにアクセスできる
PC または MTS400P 型機器を使
用して、VideoLan の Web サイト
（http://www.videolan.org）に移動し
ます。

2. Windows 自己解凍形式の VLC メ
ディア・プレーヤ・インストーラを探
して PC のハード・ディスクにダウン
ロードします。

3. 機器上にダウンロードされた VLC
メディア・プレーヤ・ファイルを探し
て実行します。

4. 使用する言語を選択します。Wel-
come / Setup スクリーンが表示され
ます。

5. セットアップ手順に従って、VLC メ
ディア・プレーヤをインストールしま
す。

注 ： VLC メ デ ィ ア ・ プ レ ー ヤ を
MTS400P 型にインストールしたら、メ
ディア・プレーヤのオーディオ機能を
無効にする必要があります。

オーディオ機能を無効にするには、
次の手順を実行します。

6. VLC メディア・プレーヤで、Settings
> Preferences を選択します。

7. Preferences ダイアログ・ボックスの
左側にあるリストから Audio を選択
します。

8. General audio settings で、Enable
audio チェック・ボックスをオフにし
ます。

9. Save ボタンをクリックし、変更を確定
して Preferences ダイアログ・ボック
スを閉じます。

MTS400P 型クイック・スタート・ユーザ・マニュアル 11
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ネットワーク構成
MTS400P 型システムは、コンピュータ・ネットワークに接続できます。正しいネットワーク設定の詳細につい
ては、ネットワーク管理者に問い合わせてください。インストールおよび操作手順については、ネットワーク・
ハードウェアおよびソフトウェアに付属のドキュメントを参照してください。

ネットワークのトラブルシューティング

ネットワークは各種規格に基づいていますが、各ネットワーク（LAN または WAN）には固有の特性が多数
存在するため、特定のネットワークに関する十分な知識がないとトラブルシューティングは困難になります。
そのため、ネットワークの詳細なトラブルシューティングは、そのネットワークの特性に精通している専門家
が実行すべきです。

このセクションでは、ネットワーク・エラーの一般的ないくつかの原因を解消できる基本的な手順を紹介しま
す。これらの手順を使用しても問題を解決できない場合は、ネットワーク管理者にお問い合わせください。

基本的な要件

ホスト・マシンのトラブルシューティングを行う前に、次の要件が満たされるようにしてください。

ネットワーク・アダプタ・カードの付属マニュアルの説明に従い、システムをネットワーク上で使用できるよ
うに設定します。詳細については、ネットワーク管理者にお問い合わせください。

テスト・システムの購入後にインストールしたアプリケーションの中に、テスト・システム・コンポーネントに
割り当てられたポートを使用しているものがないかを確認します。

IP パラメータ

このセクションでは、各 IP パラメータ（IP アドレス、サブネット・マスク、およびデフォルト・ゲートウェイ）がネッ
トワーク接続に及ぼす悪影響を図で説明します。

IP アドレスが正しくない: テスト・システムの IP アドレスが正しくない（固有でない）場合は、ネットワーク
上で通信できない可能性があります。次の図では、TVTest_1 が Rennes と同じ IP アドレスを使用していま
す。Rennes が最初に起動されると、TVTest_1 は IP アドレスの競合を認識し、TCP/IP をロードしません。こ
の結果、ネットワーク経由でシステムに到達できません。

IP アドレスが正しくなく、サブネット上に存在しない場合でも、デバイス（システムまたは監視ステーション）か
らの通信は可能な場合がありますが、デバイスへの通信は不可能になる場合があります。
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サブネット・マスクが正しくない: サブネットやサブネットを含むネットワークは複雑であり、IP アドレス指
定についての十分な知識を必要とします。発生しているネットワークの問題にサブネットが関係していると思
われる場合は、ネットワーク管理者にお問い合わせください。次の図は、単純な（比較的よく見られる）サブ
ネット・マスクの問題を示しています。

図の TVTest_1 のサブネット・マスクは、ネットワーク・アドレスが IP アドレスの最初の 2 バイトに含まれている
ことを示しています。ドット区切りの 10 進表記では、ネットワーク・アドレスは 128.181 です。この情報により、
デバイスはデフォルト・ゲートウェイ経由でルーティングされなくても、同じネットワーク・アドレスを持つ他の
デバイスと通信できます。

TVTest_1 は Carnac とは通信できません。これは、TVTest_1 のサブネット・マスクによると、Carnac と TVTest_1
が論理的に同じネットワーク上に存在するためです。この結果、TVTest_1 から Carnac に送信されたメッセー
ジはルーティングされなくなります。この 2 つのデバイスが接続を共有していないため、TVTest_1 は Carnac
のネットワーク・カードの正しいアドレスを見つけることができず、Carnac には到達できません。

TVTest_1 は、TVTest_2 および Rennes とは通信できます。それは、これら 3 つのデバイスが接続を共有し
ているため、TVTest_1 からのメッセージをルーティングする必要がないためです。したがって、正しくないサ
ブネット・マスクが設定されているにもかかわらず、TVTest_1 は TVTest_2 および Rennes の正しいアドレスを
見つけることができます。
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デフォルト・ゲートウェイの IP アドレスが正しくない: TCP/IP Properties ダイアログ・ボックスで指定し
たデフォルト・ゲートウェイは、ネットワーク上の各サブネットワークを "認識している" デバイスです。メッセー
ジ（たとえば、あるシステムから他のサブネット上のデバイスへのトラップ）を送信する場合、デフォルト・ゲー
トウェイはそのメッセージを適切なサブネットにルーティングできます。TCP/IP Properties ダイアログ・ボック
スで指定した IP アドレスが間違っていると、他のサブネット上のデバイスへのメッセージは（デフォルト・ゲー
トウェイまで届かないため）宛先には到達しません。
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一般的なトラブルシューティング手順

以降のセクションで実行する手順の多くは、一般的な作業です。

ホスト・マシンへの Ping: すべての TCP/IP インストールで提供されているユーティリティの 1 つが ping.exe
です（C：\windows\system32\ ディレクトリを探してください）。このユーティリティでは、ホスト・マシンに通信
パケットを送信し、そのマシンからの応答を記録できます。この操作により、パケットが宛先に到達したかどう
かが判別されます。Ping を実行するには、次の手順を使用します。

1. Start メニューから Run を選択しま
す。Run ダイアログ・ボックスが表示
されます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

ping machineName

ping IPaddress

この例では、machineName と IPad-
dress がそれぞれ、ping しようとして
いるネットワーク・デバイスのホスト・
マシン名と IP アドレスを表していま
す。

3. OK をクリックします。

DOS ウィンドウに、マシンが ping に
応答しているかどうかが示されます。
この図では、宛先マシン（Oxford4）
は応答していません。

Ping は短時間だけ実行され、プロ
セスが完了すると DOS ウィンドウは
閉じられます。
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TCP/IP パケットのルートのトレース: パケットが、宛先マシンまでの経路のどこまで到達したかや、その
途中でパケットがどのデバイスを通過したかがわかると便利な場合があります。この機能を提供するユーティ
リティが tracert.exe です。tracert は、ネットワーク内の混雑したポイントを示すこともできます。tracert を実
行するには、次の手順を使用します。

1. Start メニューから Run を選択しま
す。Run ダイアログ・ボックスが表示
されます。

2. Run のテキスト・ボックスに、次のい
ずれかを入力します。

tracert machineName

tracert IPaddress

この例では、machineName と IPad-
dress がそれぞれ、到達しようとして
いるネットワーク・デバイスのホスト・
マシン名と IP アドレスを表していま
す。

3. OK をクリックします。

DOS ウィンドウは、パケットの進行
状況を示しています。右端の列は、
tracert パケットを正常に通したネッ
トワーク上のノードの IP アドレスを
示しています。この情報は、宛先デ
バイスまでの経路上にある最後の
正常なノードを示しています。
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ネットワーク上にあるデバイスの IP アドレスの検索: ネットワーク上にあるコンピュータの IP アドレス
（または、IP アドレスがわかっている場合はネットワーク名）の検索や確認が必要になる場合があります。この
情報が得られると、Hosts ファイルで使用している IP アドレスやネットワーク名が正しいかどうかを確認できま
す。この情報を表示するユーティリティが nslookup.exe です。nslookup は下に説明する方法で使用します。

1. Start メニューから Run を選択しま
す。Run ダイアログ・ボックスが表示
されます。

2. 次のいずれかを入力して Enter キー
を押します。ここで、machineName と
IPaddress がそれぞれ、検索しようと
しているデバイスのネットワーク名と
IP アドレスです。

nslookup machineName

nslookup IPaddress

目的のデバイスのネットワーク名と
IP アドレスが表示されます。ネット
ワークで DNS を使用している場合
は、DNS サーバの IP アドレスとネッ
トワーク名も表示されます。

ネットワーク情報の入手先

ネットワークのトラブルシューティングに関してさらに多くの情報が必要な場合、次のリソースが役立つ可能
性があります。

注： これらのリソースではより多くの情報が提供されている可能性があります。これらの情報の大部分はそ
のまま提供されており、その適合性については、書面または黙示を問わず保証されていません。ネットワー
クに関するトラブルシューティング情報の最善の入手先は、担当のネットワーク管理者です。

Cisco Systems, Inc. – http://www.cisco.com/

このサイトは特に、Cisco 製デバイスを使用しているネットワークに役立ちます

Dulaney, E、Lawrence, S、Scrimger, R、Tilke, A、White, J、Williams, R、Wolford, K 著、『MCSE Training
Guide: TCP/IP』Indianapolis, IN. New Riders, 1998

これは、MCSE（マイクロソフト認定システムエンジニア）資格のためのトレーニング・ガイドで、TCP/IP と
ネットワークのトラブルシューティングを扱っています。

Taylor, E.著、『Network Troubleshooting Handbook』New York, NY.McGraw-Hill, 1999

機能チェック
初めて機器を作動させて機器の輸送に伴う損傷がないことを確認する場合、または機器が正常に作動して
いない疑いがある場合には、性能検査手順を実行してください。

性能検査手順については、『MTS400P 型仕様および性能検査テクニカル・リファレンス』を参照してください。
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操作

フロント・パネル・コントロールおよびコネクタ

注意： On/Standby スイッチを押して機器の電源をオフにすると、機器の現在の設定は保存されません（こ
の操作は Windows XP の緊急時シャットダウンに相当します）。データの損失を防ぐために、機器の電源を
オフにするには File メニューで Shutdown コマンドを使用してください。

表 4: フロント・パネル・コントロールおよびコネクタ

コントロール 機能

On/Standby スイッチ 機器の電源をオンまたはオフにするには、このボタンを押します。

Stop ボタン このボタンは次の機能を実行します。

ストリーム・データの出力中にこのボタンを押すと、データ出力が停止
します。

機器がトリガ・イベントの待機状態でプリトリガ部分の採取中、または
ポストトリガ部分の記録中にこのボタンを押すと、記録されたデータが
ファイルに保存されます。
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表 4: フロント・パネル・コントロールおよびコネクタ （続き）

コントロール 機能

Enter ボタン 選択したメニュー・コマンドを実行したり、ダイアログ・ボックス内のすべて
の設定変更を有効にするには、このボタンを押してください。

Cancel/Close ボタン 選択した操作をキャンセルするには、このボタンを押してください。何らか
のメニュー・コマンド・リストが表示されている場合、そのコマンド・リストは
一時的に閉じられます。

Play/Pause ボタン このボタンは次の機能を実行します。

このボタンを押すと、データ出力が開始されます。

このボタンを Record 画面の表示中に押すと、Play 画面に切り替わり
ます。

このボタンをストリーム・データの出力中に押すと、データ出力が一時
停止します。ストリーム出力を再開するには、もう一度このボタンを押し
てください。

M-TMCC トランスポート・ストリームが選択されている場合、MTS400P 型
システムはスーパー・フレームの開始パケットからスーパー・フレーム数
の整数倍でループ可能な最大パケット数になるまでストリームを出力しま
す。ISDB-T トランスポート・ストリームが選択されている場合、MTS400P 型
システムは OFDM（直交周波数分割多重）フレーム内の開始パケットから
OFDM フレーム数の 2 の倍数でループ可能な最大パケット数になるまで
ストリームを出力します。ISDB-T トランスポート・ストリームのいずれかのトラ
ンスポート・ストリームに異なる変調パラメータがある場合は、Play メニュー
の Packet Size コマンドで Non TS を選択してください。

ストリーム･データの出力中は、ボタン内のステータス･インジケータのライ
トが点灯します。ストリーム出力が一時停止すると、ライトは点滅します。

Record ボタン このボタンは次の機能を実行します。

入力されているストリーム･データを記録するには、このボタンを押しま
す。

Play 画面の表示中にこのボタンを押すと、Record 画面に切り替わりま
す。

同期ワードの検出時、またはストリーム・データのプリトリガ部分が記録さ
れた場合には、ボタン内のステータス・インジケータ・ライトが点滅します。

HDD アクセス・インジケータ ハード・ディスク・ドライブの作動中はこのインジケータが点灯します。

Menu ボタン メニュー・コマンド・リストの表示をオンまたはオフに切り替えるには、この
ボタンを使用します。

矢印ボタン LCD 画面での操作は、この矢印ボタンを使用します。たとえば、アイコン・
カーソルの移動やメニュー項目間の移動にはこれらのボタンを使用しま
す。

Num Pad/Select ボタン ダイアログ・ボックスで行われたすべての変更を有効または無効にするに
は、このボタンを押します。このボタンはキーパッドを開く際にも使用され、
そのキーパッドでテキスト・ボックスに数値を入力できます。

Play 画面で ISDB-T ファイルが選択されている場合、または Record 画面
で ISDB-T 信号が取り込まれている場合には、このボタンを押すと ISDB-T
Information ダイアログ・ボックスが開きます。
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表 4: フロント・パネル・コントロールおよびコネクタ （続き）

コントロール 機能

Tab ボタン 開いたダイアログ・ボックスで数値パラメータを選択するには、このボタン
を使用します。

USB コネクタ 機器に同梱のキーボードとマウスを Windows 操作用に接続するには、
USB 2.0 コネクタを使用します。他の USB デバイスも接続できます。

リア・パネル・コネクタ
リア･パネル・コネクタについては、「設置」セクションで説明します。 (7 ページ 「リア・パネル・コネクタ」 参照)。

ソフトウェア・アプリケーション
MTS400P 型 MPEG テスト・システムには、リアルタイム解析およびデファード（オフライン）解析に必要なす
べてのツールが用意されています。これらのツールには、TS（トランスポート・ストリーム）コンプライアンス、
バッファ、PES、MPEG2、および MPEG4 のビデオおよびオーディオ・エレメンタリ・ストリーム・アナライザがあ
ります。ストリーム・コンテンツやテストおよびエラー・ストレス・ストリームを作成するためのエディタおよびマ
ルチプレクサもあります。

一部のオプションが有効になっていない場合があることに注意してください。すべてのアプリケーションの詳
細については、MTS400 シリーズ MPEG テスト・システムのアプリケーション・ユーザ・マニュアルを参照して
ください。

批准された DTV 規格や更新される DTV 規格を幅広くサポートするカスタマイズ可能な組込みスクリプトを
通して、規格への適合性が保証されます。新しい規格や独自仕様のテーブルは、当社が提供する更新を
読み込むか、または独自のカスタム・スクリプトを作成することにより簡単に実装できます。

アプリケーション
デスクトップ・
アイコン 1

アナライザ

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）- リアルタイムのトランスポー
ト・ストリーム解析。MPEG-2、DVB、ATSC、および ISDB からテスト項目を選択可能。トラ
ンスポートの構造、ヘッダの内容、パケットの内容の 16 進表示、PCR タイミング／トランス
ポート・レート・グラフ、およびエラー・メッセージ・ログを表示します。

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）- デファード・トランスポート・
ストリーム解析。MPEG-2、DVB、ATSC、および ISDB からテスト項目を選択可能。トランス
ポートの構造、ヘッダの内容、パケットの内容の 16 進表示、PCR タイミング／トランスポー
ト・レート・グラフ、およびエラー・メッセージ・ログを表示します。

パケット化エレメンタリ・ストリーム（PES）アナライザ - テスト項目を選択して PES 解析を実行
可能。PES プログラム構造、ヘッダの内容、パケットの内容、PTS/DTS タイミング・グラフ、
および解析レポートを表示します。
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アプリケーション
デスクトップ・
アイコン 1

トランスポート・ストリーム - システム・ターゲット・デコーダ（T-STD）バッファ・アナライザ -
プログラム・ストリームを、MPEG-2 T-STD バッファ・モデルに対する動作および適合性をシ
ミュレーションすることにより解析します。トレース機能も搭載されています。

エレメンタリ・ストリーム・アナライザ - 映像およびオーディオ・レベルでのエレメンタリ・スト
リーム解析。これには、ベクトル・グラフとマクロブロックのピクチャ品質が含まれます。

カルーセル・アナライザ - データ項目の構造、ビット・レート、反復レート、構文、およびセ
マンティクスを表示するデータ解析。

ゼネレータ

カルーセル・ゼネレータ - さまざまなデータ放送プロトコルを含む MPEG-2 および DVB ト
ランスポート・ストリームをオフラインで詳細に生成します。

マルチプレクサ - テーブル情報とパケット化エレメンタリ・ストリームを 1 つに多重化して、
新しいトランスポート・ストリームを合成します。新しいトランスポート・ストリームに対して非適
合性およびテスト・ケースを指定できるように、きめ細かい制御が可能です。

TS エディタ - パケットの内容の 16 進表示とヘッダのセマンティクス解釈を使用して、トラン
スポート・ストリーム・パケットを表示および編集します。PID の再マッピング、PCR 値の再計
算、PCR 誤差の導入などの機能を提供します。

プレーヤ

MPEG Player - MPEG-2 ストリームを記録および再生します。

ユーティリティ

シームレス化機能 - ストリーム・プレーヤの連続ループ･モードで使用する MPEG-2 ファイ
ルの作成手順を示します。
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アプリケーション
デスクトップ・
アイコン 1

ストリーム・カッタ - MPEG-2 ファイルの一部を切り取って新しいファイルに抽出します。

スクリプト・パッド - システム情報（SI）スクリプトの作成と変更に使用します。

TTS ユーティリティ - タイム・スタンプが押されたトランスポート・ストリームを、標準のトラン
スポート・ストリーム・フォーマットに変換します。

1 インストールされている場合。

アプリケーションの起動
アプリケーションはすべて、Start > All Programs > Tektronix MTS400 メニューから起動されます。

MTS400 シリーズ・システム・アプリケーション・ユーザ・マニュアルに、すべてのアプリケーションの説明が記
載されています。以下の表は、Start メニューのアプリケーション階層を示しています。

メニュー階層

Analyzers > Buffer Analyzer

Carousel Analyzer

ES Analyzer

PES Analyzer

TS Compliance Analyzer

Carousel Generator

Multiplexer

Generators >

TS Editor

Player > MPEG Player

Make Seamless Wizard

ScriptPad

Stream Cutter

Utilities >

TTS Utility

Tektronix MTS400 >

OptionKey Wizard

注： Start メニューに表示されるアプリケーションのうち、開くことができるオプションは購入済みのものだけ
です。
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メニュー・コマンドへのアクセス

1. 開いている MTS400P 型アプリケー
ションのメニュー・コマンドへのアク
セスは、次の手順で行います。

Menu ボタンを押すと、File メ
ニューのコマンド・リストが開き
ます。コマンド・リストを移動する
には、上（▴）または下（▾）矢印
ボタンを使用します。Enter ボタ
ンを押して、選択したコマンドを
実行します。目的のメニューを
選択するには、左（◄）または右
（►）矢印ボタンを使用します。一
時的にコマンド・リストを閉じるに
は、Cancel/Close ボタンを押し
ます。

2. 再度 Menu ボタンを押して、メ
ニュー・コマンド・リストを閉じます。

注： File メニューが表示されている間
に左矢印ボタンを押した場合、または
Utility メニューが表示されている間に右
矢印ボタンを押した場合には、Windows
Control メニューが表示されます。

メニュー・コマンドの表示形態

メニュー・コマンドには次の 3 つの表示
形態があります。

後ろに ►が付いたコマンドは、Enter
ボタンまたは右（►）矢印ボタンを押
した後で、対応するサブメニューが
表示されることを示しています。

後ろに省略符号（...）が付いたコマ
ンドは、Enter ボタンを押した後で、
対応するダイアログ・ボックスが開く
ことを示しています。

コマンド名単独の場合は、Enter ボ
タンを押すと、そのコマンドが実行
されます。
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数値データの入力

キーパッドの使用

1. パラメータを変更するダイアログ･
ボックスを開きます。

2. Tab ボタンを何度か押して、開いた
ダイアログ・ボックスで変更したい数
値パラメータを選択（ハイライト）しま
す。

3. Num Pad/Select ボタンを押して、
キーパッドを開きます。

4. Tab ボタンまたは矢印ボタンを押し
て、入力したい数字まで移動します
（キーパッドが最初に開いたときに
は、点線のボックスが ENT キーの
上に置かれています）。

5. Num Pad/Select ボタンを押します。
これで選択した数字が数値入力ボッ
クスに表示されます。

6. ステップ 4 および 5 を繰り返して、
目的のパラメータ値を入力します。

7. Enter ボタンを押します（または、
ENT キーを選択してから Num
Pad/Select ボタンを押します）。こ
れで新しい値が数値入力ボックス
に保存され、キーパッドが閉じられ
ます。

矢印ボタンの使用

矢印ボタンで値を変更するには、次の手順を実行します。

1. パラメータを変更するダイアログ･ボックスを開きます。

2. Tab ボタンを何度か押して、開いたダイアログ・ボックスで変更したい数値パラメータを選択します。

3. 左（◄）矢印ボタンを押して、パラメータの編集を開始します。この操作により末尾の桁がハイライトされます。

4. 左（◄）または右（►）矢印ボタンを押して、ハイライトされたカーソルを目的の値まで移動させます。

5. 値を増減するには、上（▴）または下（▾）矢印ボタンを押します。

6. ステップ 4 および 5 を繰り返して、目的の値をすべて入力します。桁を増やすには、左（◄）矢印ボタン
を押します。

7. Enter ボタンを押すと、変更された数値が保存されます。

MTS400P 型クイック・スタート・ユーザ・マニュアル 25



操作

デュプレックス操作
MTS400P 型システムはデュプレックス・モードで操作できます（ASI/SMPTE/DVB Parallel（SPI）のみ）。たと
えば、プレーヤがストリームを再生しているときに、トランスポート・ストリーム・コンプライアンス・アナライザが
別のストリームを解析できます。または、出力が入力へループバックされる場合は、プレーヤの出力をトラン
スポート・ストリーム・コンプライアンス・アナライザ（TCSA）で監視できます。

ループバックのセットアップ

ループバックを実行すると、次のことが可能になります。

MPEG Player を使用してストリームを再生する

機器の出力を入力へループバックする

TSCA を使用して入力ストリームを監視／解析する

開始する前に：

再生するストリームを識別する（この例では、sym1.mpg テスト・ストリームを使用）

出力／入力インタフェース（ASI/SMPTE310 または DVB SPI）を選択し、機器の後部で必要な接続（コネ
クタ間のループ）を行う

次の例では、ストリームが ASI インタフェースを使用してループバックされ、プレーヤで連続再生のために
ループされます。

注： BNC コネクタを介して信号を入力するには ASI または SPMTE310 を選択できます。DVB SPI 出力は、
プレーヤの設定にかかわらず、デフォルトで有効になっています。IP サポートはデフォルトでは無効になっ
ています。

MPEG player のセットアップ:

1. Start > Programs > Tektronix MTS400 > Player > MPEG Player を選択して、MPEG Player を開きます。

2. File > Open... > sym1.mpg を選択して、ストリームを開きます。

3. Play メニューで次の設定を行います。

Packet size： 188

Update：On

Sync：TS Packet

Loop：On

Other：Standard：DVB
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TSCA のセットアップ:

1. Start > Programs > Tektronix MTS400 > Analyzers > TS Compliance Analyzer を選択して、TSCA を開き
ます。

2. 最初に表示されるダイアログ・ボックス（Open Transport Stream...）の Stream Interpretation で、Change...
を選択し、拡張機能のない DVB ベース規格を選択します。Stream Interpretation ダイアログ・ボックスを
閉じます。

3. Real-time Analysis を選択し、Interfaces ドロップダウン・リストから ASI を選択します。

4. OK を選択します。

再生と解析の開始:

1. MPEG Player ウィンドウに戻り、次の手順でストリームを再生します。Play > Start/Stop またはツール・
バー・ボタンを使用します。

2. プレーヤ・ウィンドウでは、ステータス・バーが表示され、再生が開始されています。

3. TSCA ウィンドウに戻ると、解析が開始されています。

MPEG Player は sym1.mpg トランスポート・ストリームを再生中であり、TSCA は、機器コネクタ・パネルの ASI
入力および出力を介してストリームを監視および解析しています。

MPEG Player および TSCA の詳細については、『MTS400 シリーズ・アナライザ・アプリケーション・ユーザ・
マニュアル』を参照してください。
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手順

MTS400 シリーズ・アプリケーションの使用
MTS400 シリーズ解析ツールセットの各アプリケーションは、トランスポート・ストリームの特定の側面または層
を対象としています。以下の図は、この原理を簡略化された形で示しています。

このチュートリアルでは、アプリケーションの起動方法、以前に作成されたテスト・ストリーム（testmux.mpg）の
解析方法、および提示される結果について説明します。結果を解釈する方法については説明しません。

トランスポート・ストリーム・コンプライアンス・アナライザ

TSCA は、トランスポート・ストリームをリアルタイムおよびオフラインで解析して、さまざまな DTV 規格に適合
するかどうかをチェックします。ストリームは、さまざまな RF および IPTV インタフェースから受信できます。
TSCA の実際の用途については、「TSCA を用いたストリーム・コンテンツの検証」セクションを参照してくださ
い。 (64 ページ 「TSCA を用いたストリーム・コンテンツの検証」 参照)。
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PES アナライザ

ビデオ、オーディオ、および補助データなどの各エレメンタリ・ストリームは、パケット化エレメンタリ・ストリーム
（PES）としてまとめられます。ここで特に注目すべき点は、トランスポート・ストリーム内の各 PES パケットに関
連付けられているヘッダです。このヘッダには、含まれているエレメンタリ・ストリームに対応するデコード・タ
イムスタンプとプレゼンテーション・タイムスタンプ（DTS と PTS）が含まれています。これらのタイムスタンプ
にエラーがあると、極端な場合には受信側でリセットまたはピクチャの静止といった問題が発生します。

1. Start > Program > Tektronix
MTS400 > Analyzers > PES Ana-
lyzer を選択して、PES アナライザ
を開きます。

2. File > New を選択します。トランス
ポート・ストリーム（以前に作成され
たストリーム testmux.mpg など）を探
して、開きます。

解析の進行状況が、ステータス・
バーとイベント・ログに表示され
ます。解析が完了すると Program
Structure ビューが表示されます。
この例では、ストリームで 1 つのプ
ログラムを伝送し、そのプログラムに
は 1 つのビデオ・エレメンタリ・スト
リームと 1 つのオーディオ・エレメン
タリ・ストリームが、それぞれ PID 33
と 34 として含まれていることが分か
ります。
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3. Program Structure ビューでビデオ・
ストリームを選択します。虫めがね
アイコンは、そのストリームが選択さ
れていることを示します。

4. View メニューで各ビュー・オプション
（つまり、Event Log、Hex、Interpre-
tation、および PTS/DTS Timing）を
開きます。それぞれのアクションに
より、PES Analyzer ウィンドウに新し
いビューが開きます。ウィンドウ内に
ビューをタイル表示するには、Win-
dow > Tile オプションを使用します。

ステータス・バーの上にあるスライ
ダ・バーを使用すると、PES ストリー
ム内の任意のパケットに移動できま
す。パケットには、ファイル内のそれ
ぞれに位置に応じて、PID 内に番
号が付けられています。スライダ・
バーには、現在のパケットのパケッ
ト番号と PID が表示されます。

Packet Hex ビュー：

このビューでは、PES に含まれるすべ
てのバイトを調べることができます。

左の列の 4 桁の数値は、その行の
最初のバイトのアドレスです。

マゼンタで表示されているバイトは、
PES パケット・ヘッダであることを示
しています。このヘッダは、Packet
Interpretation ビューにグラフィック
形式で表示することができます。
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Packet Interpretation ビュー：

このウィンドウでは、現在選択されてい
るパケットのヘッダを解釈してグラフィッ
ク形式で表示します。ヘッダのサイズ
は、パケット・コンテンツによって異なり
ます。

PTS/DTS ビュー：

このビューには、選択したストリームの
タイミング解析が表示されます。X 軸に
はストリームの継続期間が秒単位で表
示されます。Y 軸には DTS の予想値
と実際値の差が表示されます。垂直の
青い線は、アクセス・ユニットごとの PTS
と DTS の差を表します。その他のアク
セス・ユニットについての情報は、サイ
ド・パネルに表示されます。

準拠しているストリームの場合は、0 ms
の Y軸上に各DTS が表示されます。エ
ラーがあるストリームの場合は、通常、
階段状に表示されます。

グラフを拡大縮小するには、ツール・
バーの虫めがねを選択し、ビューをク
リックします。このウィンドウの下部にあ
るスライダは、表示されているパケット
の、ファイルの残りの部分との相対的な
位置関係を示します。
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T-STD バッファ・アナライザ

T-STD バッファ・アナライザは、仮想的なトランスポート・ストリーム・システム・ターゲット・デコーダでのバッ
ファの動作を、ISO/IEC 13818-1 の仕様に合わせてモデリングし、ビデオ、オーディオ、およびシステム制御
の各ストリームを処理することができます。解析結果は、時間に沿ったバッファ容量のグラフ、および例外と
注目すべきイベントのログとして表示されます。バッファ・モデルに適合していないと、フレームが静止したり
受信側のリセットが発生することがあります。

1. Start > Program > Tektronix
MTS400 > Analyzers > Buffer Ana-
lyzer を選択して、T-STD バッファ・
アナライザを開きます。

2. View > Settings を選択して、設定を
確認します。

Settings ダイアログ ・ボックスの
System タブで、Packet Interpreta-
tion の MPEG2 を選択し、Pre-Scan
Packets の All Packets を選択しま
す。
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3. Video タブで、Buffer Sizes の Au-
tomatic と、Data Transfer の Auto-
matic を選択します。

4. Audio タブで、Buffer Size の Auto-
matic を選択します。

5. Settings ダイアログ・ボックスを閉じ
ます。
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6. File > New を選択して、解析する
ファイルを選択します。

7. MPEG ファイルを探して、開きます。
たとえば、以前の使用例で作成した
testmux.mpg を開きます。

開くとすぐに、別のファイル選択ダ
イアログ・ボックスが開きます。この
ダイアログ・ボックスでは、バッファ・
モデル結果（BMR）ファイルに名前
を付けて開きます。このファイルに
は、これ以降の解析結果が保存さ
れます。

デフォルトの名前を受け入れ、ファ
イルを開きます。

プログラムにより初期解析が実行さ
れ、ストリーム・リストの作成と平均ト
ランスポート・レートの計算が行われ
ます。ストリーム・リストには、ファイ
ル内のプログラムとエレメンタリ・スト
リームがすべて表示されます。この
セッションではリスト内のすべてのス
トリームに対してまだ解析が行われ
ていないため、すべてのストリーム
に Unprocessed という表記がつきま
す。

8. トランスポート・ストリームのコンテキ
スト・メニューから Process Streams
を選択して、ストリームの処理を開
始します。

解析の進捗がステータス・バーに表
示されます。
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9. PID 33 をハイライト表示し、コンテ
キスト・メニューから All Buffers を選
択します。

ビデオ・エレメンタリ・ストリームに対し
て、PID Event Log、Video Transport
Buffer、Video Multiplex Buffer、およ
び Video Elementary Buffer の各ウィ
ンドウが表示されます。（Stream List
ウィンドウは最小化されています。）

10.Window > Tile を選択して、表示さ
れたウィンドウをタイル表示します。

PID Event Log：

グローバル・イベント・ログと PID イベン
ト・ログという 2 つのイベント・ログを開く
ことができます。グローバル・イベント・
ログ（View > Global Event Log）は、初
期解析プロセスで発生した高度なイベ
ントを表示し、PID イベント・ログ（View >
PID Event Log）は、処理された各 PID
に対するイベントを表示します。

以下で説明するバッファ・グラフ・ビュー
には、次の機能があります。

ツール・バーの虫めがねアイコンを
使用して、選択したグラフを拡大縮
小できます。倍率値は、Reset Zoom
ツール・バー・ボタンでリセットでき
ます。

開いているすべてのグラフを、個別
に表示したり操作することがきます。
現在選択されているビューとすべて
のビューを同期させるには、Options
> Synchronize Views を使用します。

赤色のY軸の線は、0%および 100%
の限界を示しています。

Video Multiplex/Main Buffer：

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリ
ング結果が表示されます。オーディオ・
ストリームおよびシステム制御ストリーム
に対しては、メイン・バッファの結果が
表示されます。タイトル・バーにはスト
リーム・タイプが表示されます。
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Video Transport Buffer：

このビューには、ビデオ・ストリームに対
するマルチプレクス・バッファのモデリ
ング結果が表示されます。

Video Elementary Buffer：

このビューには、該当するビデオ・エ
レメンタリ・ストリームのみが表示されま
す。

11.View > Trace を選択して、トレース・
ログを表示します。

トレース・ログを使用すると、バッファ・
アナライザにより作成されたメッセー
ジ・ログを解析できます。これらのロ
グは、内部処理、特にビデオ・スト
リーム・タイプを詳細に解析するの
に役立ちます。トレース・ビューに
は、関心のある特定のメッセージ・
タイプに絞り込むためのフィルタリン
グ機能が備わっています。
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エレメンタリ・ストリーム・アナライザ

ES アナライザは、次世代の VC-1、AVC/H.264、および MPEG-4 の各規格、または従来の MPEG-2 と H.263
の各規格のいずれかに対する CODEC の適合性をチェックします。MPEG-2 オーディオ（ISO/IEC 13818
Part 3 および 7）、AC-3、および MPEG-4 AAC のオーディオ・デコードと波形表示もサポートされています。

ES アナライザは、ビデオ・ストリームおよびオーディオ・ストリームのさまざまな側面の解析に使用できる複合
アプリケーションです。このため、以下の手順では一部の解析画面へのアクセス方法を示しています。各画
面の内容とその意味の詳細については、『MTS400 シリーズ・アナライザ・アプリケーション・ユーザ・マニュ
アル』を参照してください。

1. Start > Program > Tektronix
MTS400 > Analyzers > ES Analyzer
を選択して、ES アナライザを開きま
す。

2. File > New を選択して、解析する
ファイルを選択します。

MPEG ファイルを探して、開きます。
たとえば、以前の使用例で作成した
testmux.mpg を開きます。

3. ナビゲーション・ウィンドウの各ノー
ドを順にクリックして、Program 1 /
PES (PID 33)、MPEG 2 Video ブラ
ンチの GOP（Group of Pictures）を
ハイライト表示します。
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4. Picture Player タブを選択します。
Picture Player のリモート・コントロー
ルが表示されます。

5. Show Information ボタンをクリックす
ると、コントロール・バーが拡大しま
す。追加情報として、表示されてい
るピクチャのファイル内の位置が示
されます。ステータス・バーには詳
細情報が表示されます。

6. コントロール・バーの再生ボタンをク
リックして、ストリームの再生を開始
します。

再生を停止すれば、他の GOP タブ
（GOP And Picture、Slice And MB）
を選択して、そのフレームの特性を
調べることができます。

7. たとえば、Slice And MB タブで
Picture Display を選択します。この
ピクチャは、Picture Player のピク
チャに対応します。

8. Picture Display の右側にある Show
MV（動きベクトル）をクリックします。
B および P フレームでは、動きベク
トルは、ピクチャに重なって表示され
る色付き矢印として表示されます。
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さらに、マウスをピクチャのマクロブ
ロック上に置くと、ピクチャを構成し
ているマクロブロックの特性を表示
できます。

9. Previous Frame ボタンおよび Next
Frame ボタンを使用すると、ストリー
ム内を前後に移動して、動きベクト
ルを比較できます。

同様の方法で、オーディオ・ストリー
ムの特性も調べることができます。

10.ナビゲーション・ウィンドウの各ノー
ドを順にクリックして、Program 1 /
PES (PID 34)、MPEG 1 Audio ブラ
ンチの GOP（Group of Pictures）を
ハイライト表示します。

オーディオ・コントロール・バーを使
用すると、オーディオ・トラックを確
認できます。出力を聴取するには、
ヘッドフォンを使用する必要があり
ます。
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イーサネット・ネットワーク・パラメータの設定
MTS400P 型システムのネットワーク・パラメータを設定するには、次の手順を実行します。

1. フロント・パネルの USB コネクタに、
機器に付属のキーボードおよびマ
ウスを接続します。これらはどちら
側のコネクタに接続しても構いませ
ん。

2. File > Minimize または File > Exit を
選択して、Play（または Record）画面
を閉じます。Windows XP デスクトッ
プが表示されます。

3. Start メニューから Settings > Con-
trol Panel を選択します。Control
Panel ウィンドウが表示されます。

4. ウィンドウ内の Network Connections
アイコンをダブルクリックします。
Network Connections ウィンドウが表
示されます。
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5. Local Area Connection アイコンを
ダブルクリックします。Local Area
Connection Status ダイアログ･ボッ
クスが開きます。
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6. Properties ボタンをクリックします。
Local Area Connection Properties
ダイアログ･ボックスが開きます。

7. ネットワーク・コンポーネント・フィー
ルドで Internet Protocol (TCP/IP)
をクリックします。

8. Properties ボタンをクリックします。

ダイアログ・ボックス内の設定は、MTS400P 型システムが接続されたネットワークに DHCP（Dynamic Host
Configuration Protocol）サーバが存在するかどうかによって決まります。
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DHCP サーバがネットワークに存在する場合

DHCP サーバがネットワーク内に存在する場合には、ステップ 9 および 10 を実行してください。存在しな
い場合には、ステップ 11 に進んでください。

9. ダイアログ･ボックスで、Obtain an IP address automatically およびObtain DNS server address automatically
を選択します。

10.OK ボタンをクリックします。

MTS400P 型は、ネットワークへの接続時に DHCP サーバにアクセスし、自動的にアドレスを取得します。

DHCP サーバの機能に関する詳細については、サーバの OS に付属のユーザ・マニュアルを参照してくだ
さい。

注： 一部のネットワーク環境では、MTS400P 型システムが DHCP サーバから自動的に IP アドレスを取得
できないことがあります。この場合、各サブメニュー項目に適切なアドレス値を入力する必要があります。

DHCP サーバがネットワークに存在しない場合

DHCP サーバがネットワークに存在しない場合は、次の手順を実行してネットワーク・パラメータを設定します。

11.MTS400P 型システムを 1 台の PC に直接接続する場合：

ダイアログ･ボックスで、Use the following IP address を選択します。

IP address パラメータを、末尾の番号を除いて PC の IP アドレスと同じアドレスになるように設定しま
す。末尾の番号は、PC の IP アドレスの末尾の番号と異なる必要があります。

Subnet mask パラメータを、PC が使用しているネット・マスク（サブネット・マスク）と同じになるように設
定します。PC でネット・マスクを使用していない場合は、数値を入力しないでください。

1 台の PC に直接接続している場合は、Default gateway を入力する必要はありません。

12.MTS400P 型システムをローカル・イーサネット・ネットワークに接続する場合：

ダイアログ･ボックスで、Use the following IP address を選択します。

ローカル･ネットワークの管理者に問い合わせて、適切なアドレスを設定します。

注意： MTS400P 型システムをローカル・イーサネット・ネットワークに接続する場合、イーサネット・ネットワー
クでの通信の競合を防ぐために、ダイアログ・ボックスに入力する番号をローカル・ネットワーク管理者に問
い合わせてください。

13.PC から ping コマンドを使用して、イーサネット接続を検証します。 (15 ページ 「ホスト・マシンへの Ping」
参照)。

44 MTS400P 型クイック・スタート・ユーザ・マニュアル



手順

オペレーティング・システム・ソフトウェアのリストア
MTS400P 型システムが起動しないか故障した場合は、この回復手順によりシステム・ソフトウェアを回復でき
ます。

注意： 回復手順を実行すると、ハード･ディスク・ドライブの内容はすべて上書きされ、システムは出荷時の
デフォルト設定にリセットされます。

Windows XP および MTS400P 型アプリケーション・ソフトウェアを回復するには、次の手順を実行します。

1. システムをリスタートして、BIOS のテストが終了したら直ちに F5 キーを押します。これにより Acronis True
Image ツールが開き、次のオプションが表示されます。

Restore

Windows

2. Restore System > Yes をクリックします。現在の構成をそのまま保持したい場合は、Windows をクリックし
ます。

"skipped probe" というメッセージは正常であり、無視して構いません。Acronis ツールがハードウェアの
情報を収集しています。

注意： 回復プロセスを開始したら、電源を切ってはいけません。プロセスをキャンセルすると、ハード･ディス
ク･ドライブの一部が回復された不安定な状態になります。データが回復されると、正常に回復が終了したこ
とをシステムが通知します。OK を選択すると、機器がリスタートして Windows XP セットアップ・ウィザードが
表示されます。ご使用機器のソフトウェアの最新版をインストールする必要があります。

注： オペレーティング･システムの回復後には、機器にインストールされていたソフトウェアは使用できなく
なっているため、再度インストールする必要があります。
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使用例

このセクションでは、次の使用例について説明します。

次のようなトランスポート・ストリームの作成、表示、および解析

マルチプレクサ・アプリケーションを使用した新しいトランスポート・ストリームの作成

トランスポート・ストリーム・コンプライアンス・アナライザ（TSCA）アプリケーションでの FlexVuPlus™ の
セットアップ

TSCA アプリケーションによる作成したストリームのコンテンツの調査

PES アナライザ、T-STD バッファ・アナライザ、および ES アナライザの各アプリケーションによる作成した
ストリームの検査

トランスポート・ストリームの作成、表示、および解析
以下の使用例では、新しいトランスポート・ストリームの作成方法と、そのストリームにおけるエラーの有無の
確認方法について説明します。

マルチプレクサを使用した新しいストリームの作成

使用例のこのセクションでは、MTS400 シリーズ・マルチプレクサ・アプリケーションを使用して新しいトランス
ポート・ストリームを作成します。意図的にエラーを 1 つ加えて、使用例の後のセクションでその影響を確認
できるようにします。

1. Start > Programs > Tektronix
MTS400 > Generators > Multiplexer
を選択して、マルチプレクサ・アプリ
ケーションを開きます。
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2. View > Interpretation を選択しま
す。

3. Stream Interpretation ダイアログ・
ボックスで、Base Standard として
DVB が選択され、Region が None
になっていることを確認します。

4. OK を選択して、Stream Interpreta-
tion ダイアログ・ボックスを閉じます。

5. File > New を選択します。

6. Navigator ウィンドウで、Transport
Stream ノードをハイライト表示し、コ
ンテキスト・メニューから Properties
を選択します。

7. Stream Properties ダイアログ・ボッ
クスで、ビット・レートとして 24.128
MBps を入力し、固定継続期間とし
て 2 分（120 秒）を入力します。OK
を選択します。

この 2 つの値がステータス・バーに
表示されていることに注意してくだ
さい。
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8. Navigator ウィンドウで、Transport
Stream ノードをハイライト表示し、
コンテキスト・メニューから Add を選
択します。

9. Transport Stream Settings ダイアロ
グ・ボックスで、Transport Stream の
識別子として 1 を入力します。

10.PAT（Program Allocation Table）フォ
ルダ・アイコン・ボタンを選択して、
PAT Timing ダイアログ・ボックスを
開きます。

Version Timing タブ・ウィンドウに表
示されている PAT タイミングの Start
Time（0 秒）と Stop Time（120 秒）
は、PAT がこのストリーム継続期間
で送信されることを意味しています。

11.OK を選択して、PAT Timing ダイア
ログ・ボックスを閉じます。

12.Transport Stream Settings ダイアロ
グ・ボックスで、Next を選択します。
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13.Optional Tables for the Stream ダイ
アログ・ボックスで、TDT（Time and
Date Table）チェック・ボックスを選
択し、TDT フォルダ・アイコン・ボタ
ンを選択します。

TDT Timing ダイアログ・ボックスで、
Start Time がゼロに設定され、Stop
Time が前に設定した継続期間と同
じ値に設定されていることを確認し
ます。

この継続時間は、若干調整されて
いる場合があるので注意してくださ
い。この例では、120 秒と設定した
継続期間が 119.99999049 と表示さ
れています。

14.Cycle Time として 1000 ms を入力
します。

15.OK を選択して、TDT Timing ダイア
ログ・ボックスを閉じます。

16.Optional Tables for the Stream ダ
イアログ・ボックスで、NIT（Network
Information Table）チェック・ボックス
を選択し、NIT Settings ボタンを選
択します。
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17.Set up the Nit ダイアログ・ボックス
で、Network Id として 1234 を入力
し、Network Name として Tek_test を
入力します。

18.Original Network Id を 2 に設定し、
Delivery System ドロップダウン・リス
トから Terrestrial を選択します。

19.Delivery System Settings ボタンを選
択します。

20.Terrestrial Settings ダイアログ・ボッ
クスで、Centre Frequency フィール
ドに 0x123456 を入力します。

21.Constellation ドロップダウン・リスト
から 2 (64-QAM) を選択します。

22.Hierarchy Info ドロップダウン・リス
トから 4 (non-hierarchical, in-depth
interleaver) を選択します。

23.Transmission Mode ドロップダウン・
リストから 1 (8k mode) を選択しま
す。

24.OK を選択して、Terrestrial Settings
ダイアログ・ボックスを閉じます。

25.OK を選択して、Set up the Nit ダイ
アログ・ボックスを閉じます。

50 MTS400P 型クイック・スタート・ユーザ・マニュアル



使用例

26.Optional Tables for the Stream ダイ
アログ・ボックスで、Next を選択し、
Transport Wizard Complete ダイア
ログ・ボックスを表示します。

以上でトランスポート・ストリームの
セットアップは完了です。ここで、何
らかのコンテンツをビデオ・エレメン
タリ・ストリームおよびオーディオ・エ
レメンタリ・ストリームの形式で追加
する必要があります。

エレメンタリ・ストリームのアクイジション: この例では、作成したトランスポート・ストリームに、ビデオ・
エレメンタリ・ストリームとオーディオ・エレメンタリ・ストリームを追加する必要があります。MTS400 型のインス
トールに付属しているサンプルのトランスポート・ストリームのいずれかから適切なストリームを解凍できます。
推奨されるストリームは Sym1.mpg です。このストリームは MTS400 型の E: ドライブにあります。

1. Start > Programs > Tektronix
MTS400 > Generators > Multiplexer
を選択して、マルチプレクサの 2 番
目のインスタンスを開きます。

2. File > Open を選択します。

3. Set MPEG File to Edit ダイアログ・
ボックスで、sym1.mpg を探して、開
きます。
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4. プログラム 1 のノードと、それに従
属する Elementary Streams ノードを
展開します。

5. PID 110 ノードをハイライト表示しま
す。この PID では、MPEG-2 ビデ
オ・エレメンタリ・ストリームが伝送さ
れます。es ファイル拡張子が自動
的に追加されます。

6. コンテキスト・メニューから Export
Elementary Stream を選択します。

7. Save As ダイアログ・ボックスで、ファ
イル名（Sym1pid110.es）を入力し、
ファイルを適切な場所に保存しま
す。

8. PID120 に対しても、同様の手順を
繰り返します。ファイルの名前は
Sym1pid120.es にしてください。

9. File > Exit を選択して、Mux のこの
インスタンスを閉じます。

以上で、ビデオ・エレメンタリ・スト
リームとオーディオ・エレメンタリ・ス
トリームの解凍は完了です。続けて
多重化タスクを実行できます。

エレメンタリ・ストリームの追加: ここで、元のマルチプレクサ・インスタンスに戻り、先程作成したエレメン
タリ・ストリームを追加できます。

1. Add a Program Wizard がオンになっ
ていることを確認し、Next を選択し
ます。手順 26 を参照してください。
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2. Add a Program ダイアログ・ボックス
で、プログラム番号として 1 を入力
します。

3. PMT Timing ダイアログ・ボックスで、
Subtable Timing タブを選択します。

サブテーブル・タイミング・サイクル
時間とは、ストリーム内でテーブルが
繰り返される期間のことです。DVB
規格における PMT の最大サイクル
時間は 500 ms です。

4. このストリームの例では、CycleTime
を 525 ms に設定します。

5. OK を選択して、PMT Timing ダイア
ログ・ボックスを閉じます。

6. Add A Program ダイアログ・ボックス
で、Next を選択します。

7. Add Service Description ダイアログ・
ボックスで、Add Service Description
チェック・ボックスを選択します。

8. Service Provider Name（Tek Broad-
casting など）を入力します。

9. Service Name（Tek1 など）を入力し
ます。

10.Service Type（1 (0x1) (digital televi-
sion service) など）を入力します。

11.Next を選択します。
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12.Add the Program Content ダイアロ
グ・ボックスで、Add を選択し、ビデ
オ・エレメンタリ・ストリームを追加し
ます。

13.Add Program Streamダイアログ・ボッ
クスで、Stream Type ドロップダウン・
リストから 2 (0x02) (MPEG-2 Video)
を選択します。

14.Source タブが選択されていることを
確認します。

15.File name を入力するか、Browse
を使用して以前セットアップした
ビデオ・エレメンタリ・ストリーム
（Sym1pid110.es）を探します。

16.File type ドロップダウン・リストから
MPEG-2 video を選択します。ファ
イルのビット・レートは自動的に入力
されます。

Timing タブを選択します。エレメン
タリ・ストリームは、以前に設定した
ストリーム長、つまり 120 秒間実行
されることに注意してください。
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17.PCR タブを選択します。Carry PCR
チェック・ボックスが選択されている
ことを確認します。

18.OK を 選 択 し て 、 Add Program
Stream ダイアログ・ボックスを閉じ
ます。

19.Add Program Content ダイアログ・
ボックスで、Add を再度選択し、オー
ディオ・エレメンタリ・ストリームを追
加します。

20.Stream Type ドロップダウン・リストか
ら 3 (0x03) (MPEG-1 Audio) を選択
します。

21.Add Program Streamダイアログ・ボッ
クスで、Source タブが選択されてい
ることを確認します。

22.File name を入力するか、Browse ボ
タンを使用して以前セットアップした
オーディオ・エレメンタリ・ストリーム
（Sym1pid120.es）を探します。

23.File type ドロップダウン・リストから
MPEG-2 audio を選択します。ファ
イルのビット・レートは自動的に入力
されます。

24.Timing タブを選択します。エレメン
タリ・ストリームは、以前に設定した
ストリーム長、つまり 120 秒間実行
されることに注意してください。

25.PCR タブを選択します。Carry PCR
チェック・ボックスがオフになってい
ることを確認します。
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26.PCR PID フィールドに 33 を入力し
ます。この値は、PCR 情報と、ビデ
オ es、Carry PCR を伝送する PID
です。

27.OK を 選 択 し て 、 Add Program
Stream ダイアログ・ボックスを閉じ
ます。

28.Next を選択します。

29.Event Information ダイアログ・ボッ
クスで、Event Information Tables
(EIT) チェック・ボックスを選択しま
す。

30.Present チェック・ボックスが選択さ
れていることを確認します。

31.Present Settings を選択します。

32.Present Events ダイアログ・ボックス
で、Add を選択して、現在のイベン
ト情報、つまり、この放送の時間を
セットアップします。Event dialog ダ
イアログ・ボックスで、Status ドロップ
ダウン・リストから 4 (running) を選択
します。

33.Start Time を 2008-08-28 10:20:00
AM に設定します。

時間と日付は、各フィールドをハイ
ライト表示し、必要な値を入力する
ことにより変更できます。

34.Event Name（Tek World など）を入
力します。

35.Description（The future of Tek など）
を入力します。

36.Duration（30 分（00:30:00）など）を
入力します。
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37.Content/Component Type ドロップ
ダウン・リストから 257 (MPEG-2
video, 4:3 aspect ratio, ...) を選択
します。

38.OK を選択して、Event ダイアログ・
ボックスを閉じます。

39.OK を選択して、Present Events ダ
イアログ・ボックスを閉じます。

40.Following チェック・ボックスが選択
されていることを確認します。

41.Following Settings を選択します。

42.Add を選択して、以降のイベント情
報、つまり、現在のイベントに続くイ
ベントをセットアップします。

43.Event ダイアログ・ボックスで、Event
Id フィールドに 1 を入力します。

44.Status ドロップダウン・リストから 1
(not running) を選択します。

45.Start Time を 2008-08-28 10:50:00
AM に設定します。

46.Event Name（Tek News など）を入力
します。

47.イベントの Description（All the latest
news from Tek など）を入力します。

48.Duration（30 分（01:00:00）など）を
入力します。

49.Content/Component Type ドロップ
ダウン・リストから 257 (MPEG-2
video, 4:3 aspect ratio, ...) を選択
します。

50.OK を選択して、Event ダイアログ・
ボックスを閉じます。

51.OK を選択して、Following Events ダ
イアログ・ボックスを閉じます。

52.Next を選択します。
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53.Program Complete ダイアログ・ボッ
クスで、Finish を選択します。

提案されたトランスポート・ストリームの
構造とコンテンツの作成が完了しまし
た。以上で、いくつかのチェックを行っ
て、ストリームが正常にコンパイルされ
ることを確認できるようになりました。

54.View > Available Bitrate を選択しま
す。

Available Bitrate グラフで、ビット・
レートが必須ビット・レート（つまり、
124.128 Mbps）内に収まっているこ
とに注意してください。

グラフ上の任意の点におけるビット・
レートを調べるには、その点をクリッ
クし、隣のテーブルから値を読み取
ります。

55.Available Bitrate グラフを閉じます。

56.Multiplex > Start を選択して、多重
化を開始します。
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57. Set TS Output File ダイアログ・ボッ
クスで、新しい多重化トランスポー
ト・ストリームの名前（TestMux.mpg
など）を入力します。

多重化の進捗状況はステータス・
バーの右側に表示されます。ウィン
ドウの水平方向のサイズが小さすぎ
る場合、進捗状況バーが非表示に
なることがあります。

以上で、エレメンタリ・ストリームと
構造情報が 1 つに多重化され、
TestMux.mpg というトランスポート・
ストリームが作成されました。

この多重化の構造は、後で必要に
応じて呼び出したり、情報を追加し
たりできるよう、保存しておくことを
お勧めします。

58.File > Export を選択します。

59.Export File ダイアログ・ボックス
で、多重化構造ファイルの名前
（TestMux.muxml など）を入力しま
す。拡張子が muxml であることに注
意してください。

60.File > Import を使用すると、いつで
も多重化構造ファイルを開いて、エ
レメンタリ・ストリームや構造情報を
追加することができます。
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FlexVuPlus™ ディスプレイのセットアップ

FlexVuPlus では、最大 4 つの解析詳細ビューを選択して同時に表示し、基本的なトランスポート・ストリーム
の監視や詳細な診断監視を容易に行うことができます。

ここでは、説明の便宜上、現在表示さ
れているすべての FlexVuPlus パネル
をいったん閉じるものとします（各パネ
ル右上隅の X をクリックします）。

これは必須ではありませんが、こうして
おけば、各パネルを配置する手順が
理解しやすくなります。これ以降は、
FlexVuPlus の各パネルを番号順に説
明します。

パネル 1 のセットアップ

1. Analysis タブをクリックし、次に Tests
タブをクリックします。

すべての詳細ビューの右上隅に
FlexVuPlus パネル選択ボタンがあり
ます。このボタンを使用して、選択し
た FlexVuPlus パネルに詳細ビュー
の複製を表示できます。

2. Test Summary ビューで FlexVuPlus
パネル選択ボタンを使用して、この
ビューをパネル 1 に複製します。
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3. これで、FlexVuPlus のパネル 1 に
Test Summary ビューが表示されま
す。

パネル 2 のセットアップ

4. Analysis タブをクリックし、次に Pro-
grams タブをクリックします。

5. Thumbnails ビューで FlexVuPlus パ
ネル選択ボタンを使用して、この
ビューをパネル 2 に複製します。
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6. これで、FlexVuPlus のパネル 2 に
Thumbnail ビューが表示されます。

パネル 3 のセットアップ

7. Analysis タブをクリックし、次に Tests
タブをクリックします。

8. Test Failures ビューで FlexVuPlus
パネル選択ボタンを使用して、この
ビューをパネル 3 に複製します。
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9. これで、FlexVuPlus のパネル 3 に
Test Failures ビューが表示されま
す。

この例では 3 つのパネルしか使用
していないので、Thumbnail ビュー
を拡大し、FlexVuPlus™ の右側全体
に表示できます。

パネルの垂直方向拡大ボタンを選
択して、パネル 2 を縦方向に拡大
できます。

（同様に、パネルを横方向に拡大
するには、パネルの水平方向拡大
ボタンをクリックします）。
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10. パネル 2 を拡大して、総合的な
FlexVuPlus 基本監視ビューのでき
あがりです。

このビューでは次の項目をすぐに確認できます。

Tests Summary ビュー（FlexVuPlus パネル 1）- 失敗したテスト

Test Failures ビュー（FlexVuPlus パネル 3）- 直近に失敗したテスト

Thumbnails ビュー（FlexVuPlus パネル 2）- ビデオ・コンテンツを配信中のエレメンタリ・ストリーム

TSCA を用いたストリーム・コンテンツの検証

以前の使用例で作成したサンプルのトランスポート・ストリーム（testmux.mpg）を、トランスポート・ストリーム・
コンプライアンス・アナライザを用いてオフラインで検証します。

1. File > Program > Tektronix MTS400
> Analyzers > TS Compliance Ana-
lyzer を選択して、トランスポート・ス
トリーム・コンプライアンス・アナライ
ザを開きます。

64 MTS400P 型クイック・スタート・ユーザ・マニュアル



使用例

TSCA ツール・バーで、Open File を
選択します。

オフライン解析のセットアップを選
択する前に、Select Real-time Inter-
face ダイアログ・ボックスを閉じなけ
ればならない場合があります。

Open File Analysis ダイアログ・ボッ
クスで、Base Standard が DVB に、
Region が No Extensions になって
いることを確認します。

サンプル・ストリーム（tetsmux.mpg）
を探して、選択します。

Advanced Settings タブで、Stream
Bit Rate および Timestamp Settings
が右図のように設定されていること
を確認します。

解析が完了するまでには、しばらく
かかります。

2. Analysis タブを選択し、ナビゲーショ
ン・ビューおよび関連するビューを
表示します。

3. Programs タブを選択し、プラス記号
をクリックしてナビゲーション・ビュー
の各ノードを展開します。

詳細ビューで、Summary ビューと
Tests ビューが表示されていること
を確認します。

Transport Stream ノードと Program
ノードが両方とも赤くなっています。
これは、そのストリームでエラーが発
生し、現在もアクティブであることを
示しています。

4. Transport Stream ノードをハイライ
ト表示します。Tests Summary 詳細
ビューの TR 101 290 タブで、テスト
1.5.a PMT がエラーを示しており、
関連する LED が赤くなっていること
に注意してください。
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5. テスト 1.5.a PMT をハイライト表示
し、Tests ツリーでコンテキスト・メ
ニューから View this test を選択し
ます。

Tests タブのビューが表示されます。
ナビゲーション・ビューが展開され、
エラーになったテストが表示されま
す。詳細ビューには、ハイライト表示
されたテストに関連する PID（この例
の場合は、なし）が表示されます。
さらに、ハイライト表示されたテスト
に関するイベントのみを表示するよ
うフィルタリングされたイベント・ログ
が表示されます。

ログ・エントリにエラー情報があるか
どうかを検証します。エラー・レポー
トでは 525 ms という継続期間を参
照していることに注意してください。
これは、PMT セクションの反復レー
トです。525 ms は、以前に作成した
サンプル・ストリームで設定した値で
す。

6. ナビゲーション・ビューで 1.5 PMT
(Timer) テストをハイライト表示し、
コンテキスト・メニューから Edit Pa-
rameters を選択します。

7. Edit Parameters ダイアログ・ボック
スで、このストリームに対して PMT
section max. repetition interval が
500 ms に設定されていることに注
意してください。このストリームで見
つかった反復レートがこの値（525
ms）を超えているため、エラーとして
レポートされています。ただし、Edit
Parameters ダイアログ・ボックスに表
示されている最大および最小の反
復レートを調べると（マウス・ポイン
タを値フィールド上に置き、ツール
チップを参照する）、525 ms という
レートが、DVB 規格で推奨されてい
る範囲（40 ms ～ 25000 ms）内にあ
ることが分かります。
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IP ストレス･テスト
ポータブル PC を使用して、MTS400P 型システムの IP ストレス生成機能を設定して試行するには、次の手
順を実行します。

注： MTS400P 型システムに TSCA オプションがインストールされている場合にのみ、機器の IP ストレス・テ
ストを実行できます。

設定

1. ポータブル PCの LANポートおよび
MTS400P 型システムの LAN ポート
にイーサネット・ケーブルを接続しま
す。

2. MTS400P 型システムおよびポータ
ブル PC の両方の電源を入れます。

3. MTS400P 型 シ ステ ム の MPEG
Player アプリケーションを開始しま
す。ポータブル PC にセキュリティ・
ドングルが接続されていることを確
認して、TSCA アプリケーションを
開始します。

4. MPEG Player アプリケーションで、
Play > Interface >IP を選択します。

5. IP > Configuration を選択します。

Source IP アドレスをメモし、Trans-
mission Mode が Multicast に設定さ
れていることを確認します。
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6. MTS400P 型 Configuration メニュー
で OK を選択し、D：ドライブからテ
スト・ストリームを選択します。

7. MTS400P 型システムの PLAY ボタ
ンを押して、選択したストリーム・ファ
イルの再生を開始します。

8. TSCA アプリケーションを開き、
Stream Interpretation の設定がデモ
に適合していることを確認します。

9. TSCA で、Real-time を選択し、次に
Browse を選択します。

MTS400P 型の Configuration ウィン
ドウと同じソース IP アドレスを持つ
フローが 1 つ表示されるはずです。
これは、TSCA で MTS400P 型のト
ラフィックが認識されていることを意
味します。
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10.UDP flow ダイアログ･ボックスのブ
ラウザで、フローを選択して OK
をクリックします。Select Real time
Interface ダイアログ･ボックスで OK
をクリックします。

ストリームのリアルタイム解析が
TSCA に表示されます。ストリーム
にエラーがなければ、TSCA ではす
べて緑が表示されます。

IP ストレス・テストの出力（マルチキャスト）

この手順では、MPEG Player を IP モードで再生し、TSCA を使用して出力ストリームを解析します。

1. TSCA で、Now Playing を選択し、
サムネイルの下の Play ボタンをど
れか 1 つ選択します。VLC が開始
され、デコードされたビデオが表示
されます。

これは STB がビデオをデコードす
るのと同じです。

2. クロスレイヤ・タイミング・グラフを見
るには、次の手順を行います。

左側の階層表示のフィールドで
PCR PID を選択します。

右側のフィールドで Timing
Graphs を選択し、PCR Arrival
Interval、PTS Arrival Interval、
PCR Inaccuracy、 および PIT を
追加します。

グラフの 1 つをクリックすると、
他の 3 つのグラフ上でも同時に
カーソルと値が表示されることが
分かります。
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3. MTS400P 型の階層表示で PCR
PID を選択して右クリックします。
PCR Inaccuracy ダイアログ･ボック
スで、次の手順を実行してジッタを
挿入します。

Period を 100 パケットに設定し
ます。

Amplitude を 5/27MHz （500 ns
以内）に設定します。

タイミング・グラフで影響を見ます。

4. PCR Inaccuracy ダイアログ･ボック
スで、Amplitude 20/27MHz を 740
ns に変更します。

PCR Accuracy test 2.4 はエラーと
なりますが、VLC ビデオ・デコード
はこのレベルの PCR Inaccuracy で
は影響をあまり受けないことが分か
ります。

これはネットワークで伝送される IP
パケットによる良好なビデオ伝送の
例ですが、エンコードや多重化の
過程で PCR 値にエラーが追加され
ています。

5. MTS400P 型アプリケーションで、次
の手順を実行します。

IP > Parametric Settings を選択
します。

Parametric Settings ダイアログ・
ボックスで、Jitter Distribution を
Sinusoidal、継続期間を 50% に
設定します。

これは、イーサネットの通常のパケッ
ト間ギャップから最大 50% の変動を
表しています。
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6. タイミング・グラフで影響を見ます。
パケットの到着タイミングの変動
に従って、PCR Arrival Interval、
PTS Arrival Interval および Packet
Inter-arrival time の Min 値および
Max 値がそれぞれ増加します。

これはネットワーク・パフォーマンス
が低いことを意味し、またネットワー
クが MPEG ストリームのタイミングに
与え得る影響を示しています。

7. Parametric Settings ダイアログ・ボッ
クスで、Jitter Distribution の継続期
間を 50% から 100% に変更します。

PCR Arrival Interval、PTS Arrival
Interval および Packet Inter-arrival
time の Min 値および Max 値がそ
れぞれ増加します。
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8. VLC デコード後のビデオに対する
影響を見るには、次の手順を行い
ます。

Program タブ、左側の Transport
Stream ノード、および右側の
Now Playing タブを選択します。

Play をクリックして VLC デコー
ド後のビデオへの影響を調べま
す。

これらのグラフにより、被測定装置
でビデオのデコードが停止する時
点の IP パケット･ジッタのしきい値
を知ることができます。ネットワーク
のタイミング問題に耐えられるように
設計する場合には、これが大変重
要になります。

9. IP > Error Generation を選択して、
MTS400P 型の IP メニューで手動
によるエラー生成を選択します。
種々のエラーをクリックして、TSCA
テスト・ビュー（TSCA テスト・ツリー
で Other - IP node を参照して展
開）でパケット損失、チェックサム・
エラー、およびシーケンス・エラー
を調べます。また、VLC デコード後
のビデオでの影響も調べます。

これらの影響は、IP ビデオ・ネット
ワークにおけるパケット損失やパ
ケット破損の一般的なものです。
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10.Error Insertion ダイアログ・ボックス
で、 Enable Error Insertion のチェッ
ク・ボックスをオンにし、 Packet
Loss を選択して 10 packets/ 1000
packets を入力します。

これは 1% のパケット損失であり、
機器が確実に耐えられるために標
準的な設計仕様基準となります。
TSCA での影響を表示します（優先
度 1 CC エラーおよび IP パケット
のドロップ・エラーを探します）。ま
た、VLC デコード後のビデオでの
影響も調べます。

11. IP > Configuration > Stream replica-
tion を選択します。Number of repli-
cated streams フィールドに 4 を入
力し、宛先アドレスを変更して値を
0.0.0.0 から 0.0.0.1 に増やします。
これで、宛先アドレスが 1 ずつ増分
された 4 つの追加フロー上で選択
したファイルが再生されます。
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12.TSCA で、Open File > Real-time >
Browse を選択します。今度は複数
のフローから選択できることが分か
ります。

こうして複数のフローを生成するこ
とにより、複数の SPTS が伝送され
る実際の IPTV マルチキャスト環境
に近いものとなります。

挿入されるジッタやパケット・エラー
はパケット･フロー全体に分散され、
いずれのセッションにも等しく影響
を与えます。解析するフローをどれ
か 1 つ選択して、上述の MTS400P
型における IP ジッタおよびパケット
損失／破損に関するストレス・テス
ト・ケースの影響を評価できます。
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IP ストレス・テストの出力（ユニキャスト）

1. 「設定」のステップ 1 ～ 4 を実行
します。 (67 ページ参照)。

2. 「設定」のステップ 5 で、Trans-
mission Mode を Unicast に設定し
ます。

3. Control Panel >
Network Connection > Local Area
Connection > Properties > Internet
Protocol を選択します。

Internet Protocol (TCP/IP) Proper-
ties ダイアログ・ボックスが表示され
ます。

4. ダイアログ･ボックスで、Use the
following IP address を選択します。

5. 「設定」のステップ 5 でメモしたゼ
ネレータの Source IP アドレスと同じ
セグメント上にある IP アドレスを入
力します。(67 ページ参照)。IP アド
レスを 1 増分するのが最も容易な
方法です。

6. 「設定」のステップ 6 ～ 10 を実行
します。(67 ページ参照)。これでテ
ストの設定が完了します。「IP ストレ
ス・テストの出力（マルチキャスト）」
に記載されたテスト実施のステップ
を実行し、テストを試してみます。
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アクセサリ

スタンダード・アクセサリ
次の表は、MTS400P 型システムに付属するスタンダード・アクセサリを示しています。

数量 説明 部品番号

1 ソフトウェア・パッケージ：MTS400 シリーズ・アプリケーション・ソフトウェ
ア・メディア

020-2994-XX

1 TekRestore ソフトウェア・ライセンス 063-3906-XX

1 Certificate Of Authenticity：Microsoft Windows XP NA

1 ソフトウェア・パッケージ：MTS400 シリーズ製品マニュアル CD-ROM 063-4197-XX

1 MTS400P 型クイック・スタート・ユーザ・マニュアル

オプション L0 型（英語）

オプション L5 型（日本語）

071-2610-XX

071-2611-XX

1 補足情報シート、中国 RoHS 071-2185-XX

1 ソフトウェア・キー、パラレル・ポート・ドングル 119-6962-XX

1 USB マウス 119-6936-XX

1 USB キーボード 119-B146-XX

1 インタフェース・ケーブル（D-sub 25 ピン、ツイスト・ペア） 012-A220-XX

1 フロント・カバー 200-4716-XX

1 電源コード・

オプション A0 型（北米仕様電源）

オプション A1型（ユニバーサル欧州仕様電源）

オプション A2型（英国仕様電源）

オプション A3型（オーストラリア仕様電源）

オプション A4型（240 V 北米仕様電源）

オプション A5型（スイス仕様電源）

オプション A6型（日本仕様電源）

オプション A10型（中国仕様電源）

オプション A11型（インド仕様電源）

オプション A99型（電源コードまたは AC アダプタなし）
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オプショナル・アクセサリ

MTS400P 型オプショナル・アクセサリ

オプショナル・アクセサリを次に示します。

数量 説明 部品番号

オプション IPTVP 型

1 ケーブル・アセンブリ：RF、BNC-BNC、75 Ω 174-5135-XX

オプション SX 型

1 850 nm 光ポート 131-7834-XX

オプション LX 型

1 1310 nm 光ポート 131-7957-XX

オプション ZX 型

1 1550 nm 光ポート 131-7958-XX
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ユーザ・メンテナンス

この付録では、MPEG テスト・システムの一般的な注意事項と保守の手順について説明します。

「予防保全」では、クリーニングの手順について説明します。

「問題が発生した場合」では、起動エラーのトラブルシューティングのヒントをいくつか示します。

「輸送用の再梱包」では、機器を梱包して輸送するための手順を示します。
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一般的な注意事項
機器は、厳しい気候条件から保護する必要があります。この機器は防水加工されていません。

注意： スプレーや液体、溶剤に接触させないでください。機器が損傷する可能性があります。

化学薬品の洗浄剤を使用しないでください。機器を損傷する恐れがあります。ベンゼン、トルエン、キシレ
ン、アセトンまたはこれに類似する溶剤を含有する化学薬品を使用しないでください。

予防保全
年に一度、電気的な性能をチェックし、機器の確度を検証（校正）する必要があります。

予防保全は、主に定期的なクリーニングによって実現されます。定期的にクリーニングすることにより、機器が
故障しにくくなり、信頼性が高まります。動作環境に基づき、必要に応じて機器をクリーニングする必要があり
ます。コンピュータ室のような条件に比べると、汚れた条件下ではより頻繁にクリーニングする必要があります。

外部のクリーニング

機器の外部表面のクリーニングには、乾いた柔らかい布か柔らかい毛ブラシを使用してください。汚れが落
ちない場合は、75% のイソプロピル・アルコール溶剤をしみこませた布または綿棒を使用してください。コント
ロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちます。機器のどの部分にも研磨剤を使
用しないでください。

注意： 外部のクリーニング時に機器の内部が湿らないように、布または綿棒が湿る程度の量の溶剤のみを
使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を使用し、純水で洗い流してください。

フロント・パネルの On/Standby スイッチを水拭きしないでください。機器のクリーニング中はスイッチを覆っ
てください。

キーボードのクリーニング

キーボードおよび内蔵トラッキング・デバイスの外部表面のクリーニングには、乾いた柔らかい布か柔らかい
毛ブラシを使用してください。コントロールやコネクタ周囲の狭い箇所のクリーニングには綿棒が役立ちま
す。機器のどの部分にも研磨剤を使用しないでください。

注意： 外部のクリーニング時にキーボードや内蔵トラッキング・デバイスの内部が湿らないように、布または
綿棒が湿る程度の量の溶剤のみを使用してください。洗浄剤として 75% のイソプロピル・アルコール溶剤を
使用し、純水で洗い流してください。
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問題が発生した場合
このセクションでは、テスト・システムの使用中に発生する可能性がある問題について説明します。このセク
ションでは、性能の検査や調整に関連した具体的な問題は取り上げていません。このセクションで説明する
MTS400P 型システムの診断手順は、問題の切り分けに役立ちます。性能検査の手順については、『MTS400
シリーズ製品マニュアル』CD-ROM に収録の『MTS400P 型仕様および性能検査テクニカル・リファレンス』
（PDF ファイル）を参照してください。

起動時のセルフテストは、テスト・システムのアプリケーションを起動するために機器の電源を最初にオンに
したときに実行されます。これらの診断では、オペレーティング・システムとハードウェアが正しく動作すること
がチェックされます。起動時のセルフテストでエラー・メッセージが発生した場合、MTS400P 型システム・ソフ
トウェアの起動を妨げるシステム・エラーが存在する可能性があります。

以下の表は、オペレーティング・システムと周辺機器に関連するハードウェアの問題の症状と、考えられる解
決策のいくつかを示しています。

症状 考えられる原因と推奨される対応

機器の電源がオンにならない 電源コードが機器と電源に接続されていることを確認します。

On/Standby スイッチを押したときに機器に電力が供給されるこ
と、およびファンが動作することをチェックします。

電源から電力が供給されていることをチェックします。

当社サービス受付センターにお問い合わせください。

機器の電源がオンになっても、起動時
シーケンスが完了しない

フロッピー・ディスク・ドライブを点検してディスクを取り出し、機器
がハード・ディスク・ドライブから起動していることを確認します。

起動時のセルフテストが失敗する 当社サービス受付センターにお問い合わせください。

機器が、モニタ、プリンタ、キーボード
などのアクセサリを認識しない

アクセサリが適切に接続またはインストールされていることをチェッ
クします。

当社サービス受付センターにお問い合わせください。

On/Standby スイッチで機器の電源が
オフにならない

Windows XP のシャットダウン手順に従って機器の電源をオフにし
てみてください。それでも機器の電源がオフにならない場合は、
タスク・マネージャを使用してタスクを終了します。最後に、強制
シャットダウン手順を試してください。On/Standby スイッチを 5 秒
間押したままにして、機器の電源をオフにします。

ソフトウェアに関する問題

MPEG テスト・システムはソフトウェアがインストールされた状態で納品されます。ソフトウェアに問題があると
思われる場合は、テスト・システムのアプリケーション・ソフトウェアの問題と、インストールされている他のソフ
トウェアの問題を区別するようにしてください。

ソフトウェアに関する問題の多くは、ソフトウェア・ファイルの破損または不足が原因になっています。ほとん
どの場合、ソフトウェアに関する問題を解決するための最も簡単な方法は、ソフトウェアを再インストールする
ことです。 (45 ページ 「オペレーティング・システム・ソフトウェアのリストア」 参照)。

ネットワークに問題があると思われる場合は、「ネットワークのトラブルシューティング」を参照してください。
(12 ページ 「ネットワークのトラブルシューティング」 参照)。
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ハードウェアに関する問題

ハードウェアの問題にはいくつかの原因が考えられます。このマニュアルの設置手順を見直して、機器を正
しく設置していることを確認してください。MTS400 シリーズ・システムにはユーザが保守できる部品はない
ため、ご使用の機器でハードウェアの問題が発生した場合は、当社サービス受付センターにお問い合わせ
いただく必要があります。

輸送用の再梱包
機器は、最初に当社によって、輸送中の損傷から機器を保護するための梱包資材を使用したカートンに入
れて出荷されています。機器を別の場所に輸送する必要がある場合は、輸送中に機器が適切に保護され
るように、元の輸送用カートンと梱包資材を使用することを強くお勧めします。

注意： 機器を別の場所に輸送する場合、または修理のために当社サービス受付センターに機器を返送す
る場合、機器の保証が失われないように、元の輸送用カートン（良好な状態のもの）を使用することを強くお
勧めします。

当社は、機器が損傷した状態でサービス受付センターに到着し、その原因が元のカートンまたは当社から
購入した交換用カートン（および支持用梱包資材）で輸送されていなかったことによる場合、機器の保証に
応じることはできません。元の梱包資材が紛失している場合は、当社営業所にお問い合わせいただき、交
換用梱包資材を入手してください。

梱包の検査

機器を別の場所に輸送する準備を行う場合は、現在の梱包資材の状態と、不足している資材がないかどう
かを検査することが重要です。

現在の梱包資材の状態が良くない場合、または不足している資材がある場合は、新しい梱包キットを注文
することを強くお勧めします。

交換用梱包資材

当社から新しい梱包資材を入手できます。これらの資材を入手するには、当社営業所にお問い合わせくださ
い。交換用梱包キットには、輸送のために機器を正しく梱包するのに必要な資材がすべて含まれています。
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梱包手順

機器を輸送する場合は、機器が適切に保護されるように梱包することが重要です。修理のために機器を返
送する場合、機器と共に受け取ったアクセサリを返送する必要はありません。

注： アップグレードまたは修理のためにテスト・システムを当社サービス受付センターに返送する場合は、
ソフトウェア・キーを取り外さないでください。

1. 機器を修理のために当社営業所に輸送する場合は、次の情報を示すタグを機器に添付してください。

所有者の名前と住所

機器のシリアル番号

発生した問題および必要なサービスの説明

2. 機器の前面に前面保護カバーを置きます。

3. 機器を保護用の袋に入れます。この袋は、汚れ、湿気、およびその他の破片がキャビネットに入らない
ようにします。

4. 袋の上部を機器の上の方できれいにたたみ、できるだけ平らにして梱包用テープで止めます。

5. 機器の正面に前面緩衝材をかぶせます。

6. 機器の後面に後面緩衝材をかぶせます。

7. 前後の緩衝材を付けた状態で機器を注意して持ち上げ、輸送用カートンの中に下ろします。

8. カートン内の上部にダンボール・トレイを置き、前後の緩衝材の上に載るまで下に押し込みます。

注： 梱包の完全性と製品の安全を保証するために、梱包内にアクセサリが含まれているかどうかには関係
なくトレイをセットする必要があります。

9. アクセサリを輸送する場合は、トレイの中にアクセサリを配置します。

10.輸送用カートンを閉じてテープで止めます。

11.機器を配送先に輸送するために必要な、輸送用の適切な書類を添付します。
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ENGLISH TERMS
AC 電源の電圧要件, 2
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ASI/SMPTE Output コネクタ, 8
Cancel/Close ボタン, 20
Clock/Ref In コネクタ, 7
Com コネクタ, 9
DHCP（Dynamic Host

Configuration Protocol）, 43
Enter ボタン, 20
ES アナライザ, 38
GbE インタフェース

BNC ケーブル, 3
SFP モジュール, 4

HDD アクセス・インジケータ, 20
IEEE 1394b コネクタ, 9
IP パラメータ, 12
LAN コネクタ, 9
Menu ボタン, 20
MPEG Player のセットアップ, 26
MTS400 シリーズ・アプリケー

ション, 29
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Ping、ホスト・マシン, 15
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